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	Traditional Tale
	
	Folktale
	
	Realistic Fiction
	

	
	
	Grandma and the Great Gourd 
	
	Why the Sky Is Far Away
	
	Cocoliso

	

	
	
	
	CCSS
	
	CCSS
	
	CCSS

	READING WORKSHOP
	Minilesson 
Bank
	Map: Going from Here to There
	RI.3.10
	Poem/Illustration: Friends
	RL.3.10
	Diagram: Exploring a Rainforest Environment
	RI.3.10

	
	
	Traditional Tale: Grandma and the Great Gourd
	RL.3.10
	Folktale: Why the Sky Is Far Away
	RL.3.10
	Realistic Fiction: Cocoliso
	RL.3.10

	
	
	Describe Characters and Their Actions
	L.3.6
	Convey Information about Characters and Events
	L.3.6
	Describe Characters and How They Change
	L.3.6

	
	
	Analyze Plot and Setting
	RL.3.10
	Infer Theme
	RL.3.2
	Analyze Characters
	RL.3.3

	
	
	Use Text Evidence
	RL.3.10
	Ask and Answer Questions
	RL.3.1
	Make Inferences
	RL.3.3

	
	
	Talk About It: Ask Questions
	SL.3.1
	Write to Sources: Ask and Answer Questions
	RL.3.1
	Write to Sources: Use text evidence to support opinions
	W.3.1

	
	READING-WRITING 
WORKSHOP BRIDGE
	Academic Vocabulary
	Related Words
	L.3.5
	Synonyms and Antonyms
	L.3.5
	Context Clues
	L.3.4.a

	
	
	Word Study
	Syllable Patterns
	RF.3.3.c
	Inflected Endings
	RF.3.3
	Base Words and Endings
	RF.3.3.a

	
	
	Read Like a Writer
	Describe Figurative Language
	RL.3.4
	Analyze Graphic Features
	RL.3.7
	Analyze Imagery
	RL.3.4

	
	
	Write for a Reader
	Use Figurative Language
	W.3.3
	Use Graphic Features
	W.3.3
	Use Imagery
	W.3.3

	WRITING WORKSHOP
	Weekly Focus
	Introduce and Immerse
	Develop Elements
	Develop Structure

	
	Minilesson Bank
	Personal Narrative
	W.3.3
	Develop an Engaging Idea
	W.3.3
	Compose an Introduction
	W.3.3.a

	
	
	Narrator
	W.3.3.a
	Narrator
	W.3.3.a
	Develop an Event Sequence
	W.3.3.c

	
	
	Setting and Sequence of Events
	W.3.3.a
	Compose a Setting
	W.3.3
	Develop Dialogue
	W.3.3.b

	
	
	Brainstorm and Set a Purpose
	W.3.4
	Problem
	W.3.3.a
	Describe Actions, Thoughts, and Feelings
	W.3.3.b

	
	
	Plan Your Personal Narrative
	W.3.8
	Resolution
	W.3.3.d
	Compose a Conclusion
	W.3.3.d

	
	READING-WRITING 
WORKSHOP BRIDGE
	Spelling
	Spell Words with the VC/CV Pattern
	L.3.2.f
	Spell Inflected Endings
	L.3.2.e
	Spell Base Words and Endings
	L.3.2.e

	
	
	Language and Conventions
	Simple Sentences
	L.3.1.i
	Subjects and Predicates
	L.3.1
	Compound Sentences
	L.3.1.i



 (
UNIT 1 
SKILLS OVERVIEW
)

Copyright © Savvas Learning Company LLC. All Rights Reserved.
Savvas is not responsible for any modifications made by end users to the content posted in its original format.
 (
Essential Question
)
How does our environment affect us?
	WEEK 4
	
	WEEK 5
	

	Informational Text
	
	Myth
	

	Living in Deserts

	
	The Golden Flower

	

	
	CCSS
	
	CCSS

	Infographic: How Do 
People Survive in an Environment
	RI.3.10
	Media: The World Around Us
	RI.3.10

	Informational Text: Living in Deserts
	RI.3.10
	Myth: The Golden Flower
	RL.3.10

	Use domain-specific words
	RI.3.4
	Use descriptive words to provide sensory details
	L.3.6

	Analyze Text Features
	RI.3.7
	Analyze Descriptive Language
	RL.3.4

	Use Text Evidence
	RI.3.7
	Visualize Details
	RL.3.10

	Write to Sources: Take Notes
	W.3.8
	Talk About It: Make Pertinent Comments
	SL.3.1.c

	Figurative Language
	L.3.5.a
	Parts of Speech
	L.3.1.a

	Vowel Digraphs
	RF.3.3.c
	Diphthongs
	RF.3.3

	Explain the Use of Graphic Features
	RI.3.7
	Describe Author’s Purpose
	RL.3.10

	Use Graphic Features
	W.3.3
	Use Author’s Purpose
	W.3.3

	Writer’s Craft
	Publish, Celebrate, and Assess

	Coordinating Conjunctions
	L.3.1.h
	Edit for Legibility
	W.3.3

	Descriptive Adjectives: Comparative and Superlative
	L.3.1.g
	Edit for Verbs
	L.3.1.c

	Pronouns
	L.3.1.a
	Publish and Celebrate
	W.3.3

	Adverbs
	L.3.1.a
	Prepare for Assessment
	W.3.3

	Subject-Verb Agreement
	L.3.1.f
	Assessment
	W.3.3

	Spell Words with Vowel Digraphs
	L.3.2.e
	Spell Words with Diphthongs
	L.3.2.f

	Compound Subjects and Predicates
	L.3.1.h
	Common and Proper Nouns
	L.3.1.a
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	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_6.png]Inquiry and Research
	

	
A Safe Place to Play
	

	
	CCSS

	Leveled Research Articles
	RI.3.10

	Use Academic Words
	L.3.6

	Explore and Plan: Argumentative Writing
	W.3.7

	Conduct Research: Field Research
	W.3.7

	Collaborate and Discuss: Analyze Student Model
	W.3.1

	Refine Research: Identify Primary and Secondary Sources
	W.3.10

	Extend Research: Write a Thank You Note
	W.3.10

	Revise and Edit
	W.3.10

	Peer Review
	SL.3.1

	Celebrate and Reflect
	L.3.3.b




 (
RL.3.7, RF.3.3.c, RF.3.4.a, W.3.10, L.3.2.e, L.3.2.f
) (
RI.3.7, RF.3.3.c, W.3.10, SL.3.6, L.3.1, L.3.6
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about traditional tales and analyze plot and setting in a traditional tale.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of text to write a personal narrative.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Map: Weekly Question T18–T19
	Listening Comprehension: Read Aloud: “The Boy’s Advice” T20–T21
	Traditional Tales T22–T23
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T23
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T32–T55
»	Preview Vocabulary
»	Read: Grandma and the Great Gourd
	Respond and Analyze T56–T57
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T57
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Related Words T24–T25
	Word Study: Teach Syllable Pattern VC/CV T26–T27
	 READING BRIDGE	
	Word Study: Apply Syllable Pattern VC/CV T58–T59
	High-Frequency Words T58

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T30–T31
	Strategy, Intervention, and On Level/
Advanced Activities T30
	ELL Targeted Support T30
	Conferring T31
INDEPENDENT/COLLABORATIVE
	Independent Reading T31
	Literacy Activities T31
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T31 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T60–T61
	Strategy and Intervention Activities T60
	Fluency T60
	ELL Targeted Support T60
	Conferring T61
INDEPENDENT/COLLABORATIVE
	Independent Reading T61
	Literacy Activities T61
	Collaboration T61

	
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T350–T351
»	Personal Narrative
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T351
	Conferences T348
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T354–T355
»	Narrator
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T355
	Conferences T348

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with the VC/CV Pattern
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T352
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Review: Simple Sentences T353


	 WRITING BRIDGE	
	Spelling: Teach Words with the VC/CV Pattern T356
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Simple Sentences T357


 (
UNIT 1 WEEK 1
SUGGESTED WEEKLY PLAN
)

Copyright © Savvas Learning Company LLC. All Rights Reserved.
Savvas is not responsible for any modifications made by end users to the content posted in its original format.
 (
RL.3.1, RF.3.3.c, W.3.8, W.3.10, SL.3.1.c, SL.3.4
) (
RL.3.4, RF.3.3.d, W.3.3, W.3.4, L.3.3
) (
RL.3.2, RL.3.4, RF. 3.3.c, W.3.10, L.3.3, L.3.4.a
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Plot and Setting T62–T63
»	Close Read: Grandma and the Great Gourd
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T63
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Use Text Evidence T70–T71
»	Close Read: Grandma and the Great Gourd
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T71
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T78–T79
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T79
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Describe Figurative Language T64–T65
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Syllable 
Pattern VC/CV T66–T67
	 READING BRIDGE	
	Write for a Reader: Use Figurative Language T72–T73
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Review: Syllable Pattern VC/CV T74–T75
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Syllable Pattern VC/CV 
T80–T81
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T80

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T68–T69
	Strategy and Intervention Activities T68
	Fluency T68
	ELL Targeted Support T68
	Conferring T69
INDEPENDENT/COLLABORATIVE
	Independent Reading T69
	Literacy Activities T69
	Partner Reading T69
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T76–T77
	Strategy and Intervention Activities T76
	Fluency T76
	ELL Targeted Support T76
	Conferring T77
INDEPENDENT/COLLABORATIVE
	Independent Reading T77
	Literacy Activities T77
[bookmark: _GoBack]	Independent Reading T77
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T82–T83
	Strategy, Intervention, and On Level/
Advanced Activities T82
	ELL Targeted Support T82
	Conferring T83
INDEPENDENT/COLLABORATIVE
	Independent Reading T83
	Literacy Activities T83
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T83 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T358–T359
»	Setting and Sequence of Events
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T359
	Conferences T348
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T362–T363
»	Brainstorm and Set a Purpose
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T363
	Conferences T348
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T366
»	Plan Your Personal Narrative
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T367 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T348

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Words with the VC/CV Pattern T360
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Language and Conventions: Teach Simple Sentences T361


	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Review: Words with the VC/CV Pattern T364
	Language and Conventions: Practice 
Simple Sentences T365


	 WRITING BRIDGE	
	Spelling: Words with the VC/CV 
Pattern T368
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T368
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Standards Practice T369






 (
RL.3.2, RF.3.3.a, RF.3.4.a, SL.3.1.b, L.3.2.e, L.3.4
) (
RL.3.2, RF.3.3.a, RF.3.3.d, W.3.8, L.3.4.d, L.3.5
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about traditional tales and infer theme in a folktale.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of narrative text to write a personal narrative.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Poem: Weekly Question T88–T89
	Listening Comprehension: Read Aloud: “A Gift Horse” T90–T91
	Folktale T92–T93
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T93
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T102–T117
»	Preview Vocabulary
»	Read: Why the Sky Is Far Away
	Respond and Analyze T118–T119
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T119
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Synonyms and Antonyms T94–T95
	Word Study: Teach Inflected Endings T96–T97
	 READING BRIDGE	
	Word Study: Apply Inflected Endings T120–T121
	High-Frequency Words T120

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T100-T101
	Strategy, Intervention, and On-Level/
Advanced Activities T100
	ELL Targeted Support T100
	Conferring T101
INDEPENDENT/COLLABORATIVE
	Independent Reading T101
	Literacy Activities T101
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T101 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T122–T123
	Strategy and Intervention Activities T122
	Fluency T122
	ELL Targeted Support T122
	Conferring T123
INDEPENDENT/COLLABORATIVE
	Independent Reading T123
	Literacy Activities T123
	Partner Reading T123

	
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T374–T375
»	Develop an Engaging Idea
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T375
	Conferences T372
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T378–T379
»	Narrator
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T379
	Conferences T372

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Inflected Endings T376
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T376
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Simple Sentences T377


	 WRITING BRIDGE	
	Spelling: Teach: Inflected Endings T380
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Subjects and Predicates T381


 (
UNIT 1 WEEK 
2
SUGGESTED WEEKLY PLAN
)

Copyright © Savvas Learning Company LLC. All Rights Reserved.
Savvas is not responsible for any modifications made by end users to the content posted in its original format.
 (
RL.3.1, W.3.3, W.3.10, SL.3.1.b, L.3.2.f
) (
RL.3.1, RL.3.7, RF.3.3.c, W.3.3.a, L.3.3
) (
RL.3.2, RL.3.7, RF.3.3, W.3.3, L.3.3
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Infer Theme T124–T125
»	Close Read: Why the Sky Is Far Away
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T125
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Ask and Answer Questions T132–T133
»	Close Read: Why the Sky Is Far Away
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T133
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T140–T141
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T141
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Graphic Features T126–T127
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Inflected Endings T128–T129
	 READING BRIDGE	
	Write for a Reader: Use Graphic Features T134–T135
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Syllable 
Pattern VC/CV T136–T137
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Inflected Endings 
T142–T143
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T142

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T130–T131
	Strategy and Intervention Activities T130
	Fluency T130
	ELL Targeted Support T130
	Conferring T131
INDEPENDENT/COLLABORATIVE
	Independent Reading T131
	Literacy Activities T131
	Partner Reading T131
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T138–T139
	Strategy and Intervention Activities T138
	Fluency T138
	ELL Targeted Support T138
	Conferring T139
INDEPENDENT/COLLABORATIVE
	Independent Reading T139
	Literacy Activities T139
	Independent Reading T139
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T144–T145
	Strategy, Intervention, and On-Level/
Advanced Activities T144
	ELL Targeted Support T144
	Conferring T145
INDEPENDENT/COLLABORATIVE
	Independent Reading T145
	Literacy Activities T145
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T145 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T382–T383
»	Compose a Setting
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T383
	Conferences T372
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T386–T387
»	Problem
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T387
	Conferences T372
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T390
»	Resolution
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T391 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T372

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Inflected 
Endings T384
	Language and Conventions: Teach Subject and Predicates T385


	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Syllable  
Pattern VC/CV T388
	Language and Conventions: Practice  Subjects and Predicates T389


	 WRITING BRIDGE	
	Spelling: Inflected Endings T392
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T392
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Standards Practice T393






 (
RL.3.3, RF.3.3.a, W.3.3.a, W.3.3.c, L.3.2.e, L.3.2.f
) (
RL.3.3, RF.3.3.a, W.3.3.a, W.3.4, SL.3.2, L.3.4.a
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about themes concerning environments by analyzing characters in realistic fiction.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of narrative text to write a personal narrative.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Diagram: Weekly Question T150–T151
	Listening Comprehension: Read Aloud: “Feeling the Cold” T152–T153
	Realistic Fiction T154–T155
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T155
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T164–T179
»	Preview Vocabulary
»	Read: Cocoliso
	Respond and Analyze T180–T181
»	My View
»	Develop Vocabulary
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SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about themes concerning environments by analyzing text features in an informational text.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of narrative text to write a personal narrative.
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	I can learn more about traditional tales and analyze descriptive language in a myth.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of narrative text to write a personal narrative.
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 PROJECT FOCUS 	This week students will
	•	research what could be done to improve a local park or playground
	•	write an opinion letter to the town mayor or a park official
	
	 LESSON 1	
T470–T473 

 (
RI.3.9, W.3.7, W.3.10, SL.3.1.b, SL.3.3
)
	Compare Across Texts
•	Answer the Essential Question
	Inquire
•	Introduce Inquiry Project
•	Read “What Makes a Safe Playground?”
•	Build Background
•	Apply Academic Vocabulary
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	Explore and Plan
•	Argumentative Writing
•	Read: “Getting Outside”
•	Apply characteristics of text
	Conduct Research
•	Conduct field research
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argumentative texts
	Refine Research
•	Identify Primary and Secondary Sources
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•	Apply primary and secondary sources 
to article

	
	
	

	 LESSON 4	
 (
W.3.5, W.3.10, SL.3.1, L.3.1.d, L.3.1.e
)T482–T485
	Extend Research
•	Apply structure of a thank you note
•	Incorporate plans to write a 
thank you letter
	Collaborate and Discuss
•	Revise & Edit: Adding Details
•	Peer review letters

	
	
	

	 LESSON 5	
 (
RF.3.4, W.3.10, SL.3.1.b, SL.3.3, L.3.3.b
)T486–T487
	Celebrate and Reflect
•	Presenting your letters
•	Reflect on your project
	Reflect on the Unit
•	Reflect on your goals
•	Reflect on your reading
•	Reflect on your writing
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	WEEK 3
	

	
	
	Informational Text
	
	Informational Text
	
	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_3.png]Realistic Fiction
	

	
	
	Patterns in Nature



	
	Weird Friends



	
	Wolf Island



	

	
	
	
	CCSS
	
	CCSS
	
	CCSS

	READING WORKSHOP
	Minilesson 
Bank
	Infographic: Amazing Interactions
	RI.3.7
	Media: On the African Savanna
	SL.3.4
	Diagram: The Food Chain
	RI.3.10

	
	
	Informational Text: Patterns in Nature
	RI.3.2
	Informational Text: Weird Friends
	RI.3.10
	Realistic Fiction: Wolf Island
	RL.3.10

	
	
	Domain-Specific Words
	RI.3.4
	Scientific Words that Describe Things
	L.3.6
	Words that Connect Ideas
	RL.3.4

	
	
	Identify Main Idea and Details
	RI.3.2
	Analyze Text Structure
	RI.3.3
	Analyze Illustrations
	RL.3.7

	
	
	Monitor Comprehension
	RI.3.10
	Evaluate Details
	RI.3.2
	Synthesize Information
	RL.3.10

	
	
	Talk About It: Ask Questions
	SL.3.1.c
	Write to Sources: Respond to Text
	W.3.1
	Write to Sources: Relevant Information
	W.3.10

	
	READING-WRITING 
WORKSHOP BRIDGE
	Academic Vocabulary
	Related Words
	L.3.4.b
	Synonyms and Antonyms
	L.3.4.d
	Context Clues
	L.3.4.a

	
	
	Word Study
	Syllable Patterns VC/V and V/CV
	RF.3.3.c
	r-Controlled Vowels
	RF.3.3
	Compound Words
	RF.3.3

	
	
	Read Like a Writer
	Explain the Use of Graphic Features
	RI.3.7
	Analyze Precise Verbs
	L.3.5.c
	Analyze Author’s Message
	RL.3.10

	
	
	Write for a Reader
	Use Graphic Features
	W.3.2.a
	Use Precise Verbs
	L.3.3.a
	Use Author’s Message
	W.3.3

	WRITING WORKSHOP
	Weekly Focus
	Introduce and Immerse
	Develop Elements
	Develop Structure

	
	Minilesson Bank
	How-to Article
	W.3.2
	Develop an Engaging Main Idea
	W.3.2.a
	Develop an Introduction
	W.3.2

	
	
	Compose a Headline and Lead
	W.3.2.a
	Develop Relevant Details
	W.3.2.b
	Organize Ideas into Steps
	W.3.2.a

	
	
	Compose Facts and Details
	W.3.2.b
	Add Facts and Definitions
	W.3.2.b
	Organize Steps into Sequence
	W.3.2

	
	
	Brainstorm and Set a Purpose
	W.3.4
	Write a Command
	W.3.2
	Add Illustrations
	W.3.2.a

	
	
	Plan Your How-to Article
	W.3.4
	Clarify Steps Using Strong Verbs
	L.3.3.a
	Develop and Compose a Conclusion
	W.3.1.d

	
	READING-WRITING 
WORKSHOP BRIDGE
	Spelling
	Spell Syllable Patterns VC/V and V/CV
	L.3.2.f
	Spell r-Controlled Vowels
	L.3.2.f
	Spell Compound Words
	L.3.2.f

	
	
	Language and Conventions
	Singular and Plural Nouns
	L.3.1.b
	Irregular Plural Nouns
	L.3.1.b
	Singular Possessive Nouns
	L.3.2.d



 (
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 (
Essential Question
)
How do plants and animals live together?
	WEEK 4
	
	WEEK 5
	

	Persuasive Text
	
	Informational Text
	

	Welcome Back, Wolves! and Wolves Don’t Belong in Yellowstone
	
	Nature’s Patchwork Quilt


	

	
	CCSS
	
	CCSS

	Infographic: Bringing Animals Back
	RI.3.10
	Diagram: Plants and Animals Need Each Other
	RI.3.10

	Persuasive Text: Welcome Back Wolves! and Wolves Don’t Belong in Yellowstone
	RI.3.10
	Informational Text: Nature’s Patchwork Quilt
	RI.3.10

	Synonyms and Antonyms
	L.3.5
	Related Words
	L.3.5

	Analyze Text Structure
	RI.3.9
	Explain Author’s Purpose
	RI.3.10

	Compare and Contrast Texts
	RI.3.9
	Visualize Details
	L.3.5.b

	Write to Sources: Text Evidence
	W.3.1
	Talk About It: Pertinent Comments
	SL.3.1.c

	Figurative Language
	L.3.5.a
	Parts of Speech
	L.3.1.a

	Syllable Patterns
	RF.3.3.c
	Contractions
	RF.3.3

	Analyze Tone and Voice
	RI.3.10
	Analyze Text Structure
	RI.3.3

	Use Tone and Voice
	W.3.2
	Use Cause-and-Effect Text Structure
	W.3.10

	Writer’s Craft
	Publish, Celebrate, and Assess

	Edit for Prepositions and Prepositional Phrases
	L.3.1
	Edit for Legibility
	W.3.5

	Revising for Coherence and Clarity
	W.3.2.c
	Edit for Subject-Verb Agreement
	L.3.1.f

	Edit for Nouns
	L.3.1.b
	Publish and Celebrate
	W.3.2

	Edit for Adverbs
	L.3.1.a
	Prepare for Assessment
	W.3.2

	Edit for Coordinating Conjunctions
	L.3.1.h
	Assessment
	W.3.2

	Spell Words With Syllable Patterns
	L.3.2.f
	Spell Contractions
	L.3.2.f

	Plural Possessive Nouns
	L.3.2.d
	Main Verbs and Helping Verbs
	L.3.1.a
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	Make Note of It!



	

	
	CCSS

	Leveled Research Articles
	RI.3.10

	Use Academic Words
	L.3.6

	Explore and Plan: Informational Writing
	W.3.7

	Conduct Research: Library Databases
	W.3.8

	Informational Writing: Scrapbook
	SL.3.2

	Refine Research: Citing Sources
	RI.3.5

	Extend Research: Visuals/Media
	W.3.7

	Revise for Clarity
	W.3.5

	Edit and Peer Review
	W.3.5

	Celebrate and Reflect
	SL.3.4





 (
RF.3.3, RF.3.3.c, W.3.2, SL.3.1.c, L.3.1.b, L.3.2.f
) (
RF.3.3, RF.3.3.c, W.3.2, SL.3.2, L.3.4.b, L.3.4.c
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about informational texts and identify the main idea and details in an informational text.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of informational text to write a how-to article.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T18–T19
	Listening Comprehension: Read Aloud: “Dance of the Bees” T20–T21
	Informational Text: T22–T23
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T23
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T32–T47
»	Preview Vocabulary
»	Read: Patterns in Nature
	Respond and Analyze T48–T49
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T49

	
	 READING BRIDGE	
	Academic Vocabulary: Related Words T24–T25
	Word Study: Teach Syllable Patterns VC/V and V/CV T26–T27
	 READING BRIDGE	
	Word Study: Apply Syllable Patterns VC/V and V/CV T50–T51
	High-Frequency Words T50

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T30–T31
	Strategy, Intervention, and On-Level/
Advanced Activities T30
	ELL Targeted Support T30
	Conferring T31
INDEPENDENT/COLLABORATIVE
	Independent Reading T31
	Literacy Activities T31
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T31 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T52–T53
	Strategy and Intervention Activities T52
	ELL Targeted Support T52
	Conferring T53
INDEPENDENT/COLLABORATIVE
	Independent Reading T53
	Literacy Activities T53
	Support Collaboration T53

	
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T332–T333
»	How-to Article
»	Share Back
INDEPENDENT WRITING
	How-to Article T333
	Conferences T330
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T336–T337
»	Compose a Headline and Lead
»	Share Back
INDEPENDENT WRITING
	How-to Article T337
	Conferences T330

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Syllable Patterns 
VC/V and V/CV T334
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T334
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Common and Proper Nouns T335

	 WRITING BRIDGE	
	Spelling: Teach VC/V and V/CV Syllable Patterns T338
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Singular and Plural Nouns T339
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 (
RI.3.1, RI.3.2, W.3.2, W.3.4, SL.3.1.b, SL.3.3
) (
RF.3.3, RF.3.4, W.3.4, SL.3.1.d, L.3.1.b
) (
RI.3.2, RI.3.7, W.3.2.b, SL.3.1.a, L.3.1.b
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Identify Main Idea and Details T54–T55
»	Close Read: Patterns in Nature
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T55
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Monitor Comprehension T62–T63
»	Close Read: Patterns in Nature
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T63
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T70–T71
»	Talk About It
»	Respond to the Weekly Question
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T71

	 READING BRIDGE	
	Read Like a Writer: Explain the Use of Graphic Features T56–T57
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Syllable Patterns VC/V and V/CV T58–T59
	 READING BRIDGE	
	Write for a Reader: Use Graphic Features T64–T65
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: 
Diphthongs ou, ow, oi, oy T66–T67
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Syllable Patterns 
VC/V and V/CV T72–T73
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T72

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T60–T61
	Strategy and Intervention Activities T60
	ELL Targeted Support T60
	Conferring T61
INDEPENDENT/COLLABORATIVE
	Independent Reading T61
	Literacy Activities T61
	Support Partner Activities T61
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T68–T69
	Strategy and Intervention Activities T68
	ELL Targeted Support T68
	Conferring T69
INDEPENDENT/COLLABORATIVE
	Independent Reading T69
	Literacy Activities T69
	Support Independent Reading T69
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T74–T75
	Strategy, Intervention, and On-Level/
Advanced Activities T74
	ELL Targeted Support T74
	Conferring T75
INDEPENDENT/COLLABORATIVE
	Independent Reading T75
	Literacy Activities T75
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T75 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	How-to Article T340–T341
»	Compose Facts and Details
»	Share Back
INDEPENDENT WRITING
	How-to Article T341
	Conferences T330
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T344–T345
»	Brainstorm and Set a Purpose
»	Share Back
INDEPENDENT WRITING
	How-to Article T345
	Conferences T330
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T348
»	Plan Your How-to Article
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T349 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T330

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: VC/V and
V/CV Syllable Patterns T342
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Language and Conventions: Teach Singular and Plural Nouns T343


	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Diphthongs 
ou, ow, oi, oy T346
	Language and Conventions: Practice Singular and Plural Nouns T347


	 WRITING BRIDGE	
	Spelling: VC/V and V/CV Syllable Patterns T350
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T350
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions Standards Practice: Singular and Plural Nouns T351






 (
RF.3.4, RI.3.1, W.3.2.b, L.3.1.b, L.3.2.f
) (
RI.3.1, RI.3.2. W.3.2, W.3.2.a, SL.3.1, L.3.5
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about informational texts and analyze the structure of an informational text.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of an informational text to write a how-to article.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Media: Weekly Question T80–T81
	Listening Comprehension: Read Aloud “The Dreamtime of the Australian Aborigines” T82–T83
	Informational Text T84–T85
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T85
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T94–T109
»	Preview Vocabulary
»	Read: Weird Friends: Unlikely Allies in the Animal Kingdom
	Respond and Analyze T110–T111
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T111
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Synonyms and Antonyms T86–T87
	Word Study: Teach r-Controlled Vowels T88–T89
	 READING BRIDGE	
	Word Study: Apply r-Controlled Vowels T112–T113
	High-Frequency Words T112

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T92–T93
	Strategy, Intervention, and On-Level/
Advanced Activities T92
	ELL Targeted Support T92
	Conferring T93
INDEPENDENT/COLLABORATIVE
	Independent Reading T93
	Literacy Activities T93
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T93 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T114–T115
	Strategy and Intervention Activities T114
	Fluency T114
	ELL Targeted Support T114
	Conferring T115
INDEPENDENT/COLLABORATIVE
	Independent Reading T115
	Literacy Activities T115

	
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T356–T357
»	Develop an Engaging Main Idea
»	Share Back
INDEPENDENT WRITING
	How-to Article T357
	Conferences T354
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T360–T361
»	Develop Relevant Details
»	Share Back
INDEPENDENT WRITING
	How-to Article T361
	Conferences T354

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: r-Controlled Vowels T358
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T358
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Singular and Plural Nouns T359


	 WRITING BRIDGE	
	Spelling: Teach r-Controlled Vowels T362
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Irregular Plural Nouns T363
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 (
RF.3.3.c, RI.3.2, W.3.1.a, W.3.2.b, SL.3.1.c
) (
RF.3.3, RI.3.2, W.3.2, SL.3.1, L.3.1.b
) (
RI.3.2, RI.3.3, W.3.2.b, SL.3.1.b, L.3.1.b, L.3.5.c
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Text Structure T116–T117
»	Close Read: Weird Friends: Unlikely Allies in the Animal Kingdom
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T117
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Evaluate Details T124–T125
»	Close Read: Weird Friends: Unlikely Allies in the Animal Kingdom
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T125
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T132–T133
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T133
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Precise Verbs 
T118–T119
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: r-Controlled  Vowels T120–T121
	 READING BRIDGE	
	Write for a Reader: Precise Verbs 
T126–T127
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Syllable Patterns VC/V and V/CV T128–T129
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: r-Controlled Vowels 
T134–T135
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T134

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T122–T123
	Strategy and Intervention Activities T122
	Fluency T122
	ELL Targeted Support T122
	Conferring T123
INDEPENDENT/COLLABORATIVE
	Independent Reading T123
	Literacy Activities T123
	Partner Reading T123
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T130–T131
	Strategy and Intervention Activities T130
	Fluency T130
	ELL Targeted Support T130
	Conferring T131
INDEPENDENT/COLLABORATIVE
	Independent Reading T131
	Literacy Activities T131
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T136–T137
	Strategy, Intervention, and On-Level/
Advanced Activities T136
	ELL Targeted Support T136
	Conferring T137
INDEPENDENT/COLLABORATIVE
	Independent Reading T137
	Literacy Activities T137
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T137 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	How-to Article T364–T365
»	Add Facts and Definitions
»	Share Back
INDEPENDENT WRITING
	How-to Article T365
	Conferences T354
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T368–T369
»	Write a Command
»	Share Back
INDEPENDENT WRITING
	How-to Article T369
	Conferences T354
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T372
»	Clarify Steps Using Strong Verbs
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T373 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T354

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: r-Controlled  Vowels T366
	Language and Conventions: Teach Irregular Plural Nouns T367


	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Syllable 
Patterns VC/V and V/CV T370
	Language and Conventions: Practice Irregular Plural Nouns T371


	 WRITING BRIDGE	
	Spelling: r-Controlled Vowels T374
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T374
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Standards Practice T375
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RF.3.3, W.3.2, W.3.4, SL.3.1.d, L.3.2.f, L.3.5.b
) (
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)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about themes concerning interactions by analyzing illustrations in realistic fiction.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of an informational text to write a how-to article.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Diagram: Weekly Question T142–T143
	Listening Comprehension: Read Aloud “Producer and Consumer” T144–T145
	Realistic Fiction T146–T147
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T147
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T156–T169
»	Preview Vocabulary
»	Read: Wolf Island
	Respond and Analyze T170–T171
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T171
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Context Clues T148–T149
	Word Study: Teach Compound Words T150–T151
	 READING BRIDGE	
	Word Study: Apply Compound Words T172–T173
	High-Frequency Words T172

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T154–T155
	Strategy, Intervention, and On-Level/
Advanced Activities T154
	ELL Targeted Support T154
	Conferring T155
INDEPENDENT/COLLABORATIVE
	Independent Reading T155
	Literacy Activities T155
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T155 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T174–T175
	Strategy and Intervention Activities T174
	Fluency T174
	ELL Targeted Support T174
	Conferring T175
INDEPENDENT/COLLABORATIVE
	Independent Reading T175
	Literacy Activities T175
	Collaboration T175

	
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T380–T381
»	Develop an Introduction
»	Share Back
INDEPENDENT WRITING
	How-to Article T381
	Conferences T378
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T384–T385
»	Organize Ideas into Steps
»	Share Back
INDEPENDENT WRITING
	How-to Article T385
	Conferences T378

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Compound Words T382
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T382
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Irregular Plural Nouns T383


	 WRITING BRIDGE	
	Spelling: Teach Compound Words T386
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Singular Possessive Nouns T387
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Illustrations T176–T177
»	Close Read: Wolf Island
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T177
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Synthesize Information T184–T185
»	Close Read: Wolf Island
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T185
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T192–T193
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T193
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Author’s Message T178–T179
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: 
Compound Words T180–T181
	 READING BRIDGE	
	Write for a Reader: Use Author’s Message T186–T187
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: 
r-Controlled Vowels ar, or, ore, oar 
T188–T189
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Compound Words 
T194–T195
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T194

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T182–T183
	Strategy and Intervention Activities T182
	Fluency T182
	ELL Targeted Support T182
	Conferring T183
INDEPENDENT/COLLABORATIVE
	Independent Reading T183
	Literacy Activities T183
	Partner Reading T183
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T190–T191
	Strategy and Intervention Activities T190
	Fluency T190
	ELL Targeted Support T190
	Conferring T191
INDEPENDENT/COLLABORATIVE
	Independent Reading T191
	Literacy Activities T191
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T196–T197
	Strategy, Intervention, and On-Level/
Advanced Activities T196
	ELL Targeted Support T196
	Conferring T197
INDEPENDENT/COLLABORATIVE
	Independent Reading T197
	Literacy Activities T197
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T197 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	How-to Article T388–T389
»	Organize Steps into Sequence
»	Share Back
INDEPENDENT WRITING
	How-to Article T389
	Conferences T378
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T392–T393
»	Add Illustrations
»	Share Back
INDEPENDENT WRITING
	How-to Article T393
	Conferences T378
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T396
»	Develop and Compose a Conclusion
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T397 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T378

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Compound 
Words T390
	Language and Conventions: Teach Singular Possessive Nouns T391


	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: r-Controlled 
Vowels ar, or, ore, oar T394
	Language and Conventions: Practice Singular Possessive Nouns T395


	 WRITING BRIDGE	
	Spelling: Compound Words T398
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T398
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Standards Practice T399






 (
RF.3.3.c, RI.3.4, RI.3.9,
 
W.3.2.c, L.3.2.d,
 
L.3.5.a
) (
RF.3.3.c, SL.3.2, L.3.4.a, L.3.5.a
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about themes concerning interactions by analyzing the text structure of persuasive texts.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of an informational text to write a how-to article.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question 
T202–T203
	Listening Comprehension: Read Aloud “Recess for Middle School” 
T204–T205
	Persuasive Text T206–T207
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T207
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Texts T216–T231
»	Preview Vocabulary
»	Read and Compare Texts
	Respond and Analyze T232–T233
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T233
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Figurative Language T208–T209
	Word Study: Teach Syllable Patterns T210–T211
	 READING BRIDGE	
	Word Study: Apply Syllable Patterns T234–T235
	High-Frequency Words T234

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T214–T215
	Strategy, Intervention, and On-Level/
Advanced Activities T214
	ELL Targeted Support T214
	Conferring T215
INDEPENDENT/COLLABORATIVE
	Independent Reading T215
	Literacy Activities T215
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T215 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T236–T237
	Strategy and Intervention Activities T236
	Fluency T236
	ELL Targeted Support T236
	Conferring T237
INDEPENDENT/COLLABORATIVE
	Independent Reading T237
	Literacy Activities T237
	Collaboration T237

	
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T404–T405
»	Edit for Prepositions and Prepositional Phrases
»	Share Back
INDEPENDENT WRITING
	How-to Article T405
	Conferences T402
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T408–T409
»	Revising for Coherence and Clarity
»	Share Back
INDEPENDENT WRITING
	How-to Article T409
	Conferences T402

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Words with Syllable Patterns T406
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T406
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Singular Possessive Nouns T407

	 WRITING BRIDGE	
	Spelling: Teach Words With Syllable Patterns T410
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Oral Language: Plural Possessive Nouns T411
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Text Structure T238–T239
»	Close Read: Welcome Back, Wolves! and Wolves Don’t Belong in Yellowstone
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T239
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Compare and Contrast Texts 
T246–T247
»	Close Read: Welcome Back, Wolves! and Wolves Don’t Belong in Yellowstone
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T247
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T254–T255
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T255
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Tone and Voice T240–T241
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Syllable Patterns T242–T243
	 READING BRIDGE	
	Write for a Reader: Use Tone and Voice T248–T249
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Compound Words T250–T251
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Syllable Pattern VCe 
T256–T257
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T256

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T244–T245
	Strategy and Intervention Activities T244
	Fluency T244
	ELL Targeted Support T244
	Conferring T245
INDEPENDENT/COLLABORATIVE
	Independent Reading T245
	Literacy Activities T245
	Partner Reading T245
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T252–T253
	Strategy and Intervention Activities T252
	Fluency T252
	ELL Targeted Support T252
	Conferring T253
INDEPENDENT/COLLABORATIVE
	Independent Reading T253
	Literacy Activities T253
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T258–T259
	Strategy, Intervention, and On-Level/
Advanced Activities T258
	ELL Targeted Support T258
	Conferring T259
INDEPENDENT/COLLABORATIVE
	Independent Reading T259
	Literacy Activities T259
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T259 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	How-to Article T412–T413
»	Edit for Singular, Plural, Common, 
and Proper Nouns
»	Share Back
INDEPENDENT WRITING
	How-to Article T413
	Conferences T402
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T416–T417
»	Edit for Adverbs That Show Time and Manner
»	Share Back
INDEPENDENT WRITING
	How-to Article T417
	Conferences T402
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T420
»	Edit for Coordinating Conjunctions to Form Compound Subjects, Predicates, and Sentences
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T421 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T402

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Syllable 
Patterns T414
	Language and Conventions: Teach Plural Possessive Nouns T415

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Compound 
Words T418
	Language and Conventions: Practice Plural Possessive Nouns T419


	 WRITING BRIDGE	
	Spelling: Syllable Pattern VCe T422
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T422
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	Language and Conventions: 
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 (
RF.3.4.a, RI.3.10, SL.3.1, L.3.1.f, L.3.1.i
) (
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)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about informational texts and explain the author's purpose 
in an informational text.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of an informational text to write a how-to article.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Writing Workshop Assessment
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
	Test Banks
	Writing Workshop Performance-Based Assessment
 (
Materials
Turn the page for a list of materials that will support planning for the week.
)
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Diagram: Weekly Question T264–T265
	Listening Comprehension: Read Aloud “Amazing Monarchs” T266–T267
	Informational Text T268–T269
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T269
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T278–T293
»	Preview Vocabulary
»	Read: Nature’s Patchwork Quilt
	Respond and Analyze T294–T295
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T295
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Parts of Speech T270–T271
	Word Study: Teach Contractions 
T272–T273
	 READING BRIDGE	
	Word Study: Apply Contractions 
T296–T297
	High-Frequency Words T296

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T276–T277
	Strategy, Intervention, and On-Level/
Advanced Activities T276
	ELL Targeted Support T276
	Conferring T277
INDEPENDENT/COLLABORATIVE
	Independent Reading T277
	Literacy Activities T277
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T277 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T298–T299
	Strategy and Intervention Activities T298
	Fluency T298
	ELL Targeted Support T298
	Conferring T299
INDEPENDENT/COLLABORATIVE
	Independent Reading T299
	Literacy Activities T299
	Collaboration T299

	
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T428–T429
»	Edit for Legibility
»	Share Back
INDEPENDENT WRITING
	How-to Article T429
	Conferences T426
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T432–T433
»	Edit for Complete Sentences with Subject-Verb Agreement
»	Share Back
INDEPENDENT WRITING
	How-to Article T433
	Conferences T426

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Contractions T430
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T430
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Spiral Review: Plural Possessive 
Nouns T431


	 WRITING BRIDGE	
	Spelling: Teach Contractions T434
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	Language and Conventions: Oral Language: Main Verbs and Helping Verbs T435


 (
UNIT 
2
 WEEK 
5
SUGGESTED WEEKLY PLAN
)

Copyright © Savvas Learning Company LLC. All Rights Reserved.
Savvas is not responsible for any modifications made by end users to the content posted in its original format.
 (
RI.3.7, RF.3.3, SL.3.1, SL.3.1.c, L.3.2.f
) (
RF.3.3, RI.3.8, SL.3.1, L.3.1.a, L.3.2.f, L.3.5.b
) (
RF.3.4.a, RI.3.3, RI.3.10, SL.3.1, L.3.1.a
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Explain Author’s Purpose T300–T301
»	Close Read: Nature’s Patchwork Quilt
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T301
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Visualize Details T308–T309
»	Close Read: Nature’s Patchwork Quilt
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T309
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T316–T317
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T317
»	Respond to the Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Text Structure T302–T303
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: 
Contractions T304–T305
	 READING BRIDGE	
	Write for a Reader: Use Cause-and-Effect Structure T310–T311
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: 
Syllable Pattern VCe T312–T313
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Contractions T318–T3197
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T318

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T306–T307
	Strategy and Intervention Activities T306
	Fluency T306
	ELL Targeted Support T306
	Conferring T307
INDEPENDENT/COLLABORATIVE
	Independent Reading T307
	Literacy Activities T307
	Partner Reading T307
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T314–T315
	Strategy and Intervention Activities T314
	Fluency T314
	ELL Targeted Support T314
	Conferring T315
INDEPENDENT/COLLABORATIVE
	Independent Reading T315
	Literacy Activities T315
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T320–T321
	Strategy, Intervention, and On-Level/
Advanced Activities T320
	ELL Targeted Support T320
	Conferring T321
INDEPENDENT/COLLABORATIVE
	Independent Reading T321
	Literacy Activities T321
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T321 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	How-to Article T436–T437
»	Publish and Celebrate
»	Share Back
INDEPENDENT WRITING
	How-to Article T437
	Conferences T426
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T440–T441
»	Prepare for Assessment
»	Share Back
INDEPENDENT WRITING
	How-to Article T441
	Conferences T426
	 WRITING WORKSHOP	
MINILESSON
	How-to Article T444
»	Assessment
»	Share Back
INDEPENDENT WRITING
	Assessment T445
	Conferences T426

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: 
Contractions T438
	Language and Conventions: Teach Main Verbs and Helping Verbs T439


	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Syllable 
Pattern VCe T442
	Language and Conventions: Practice Main Verbs and Helping Verbs T443


	 WRITING BRIDGE	
	Spelling: Contractions T446
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T446
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Standards Practice T447





 PROJECT FOCUS 	This week students will
	• research plant and animal relationships.
	• create a scrapbook about a plant and animal relationship.

	 LESSON 1	
T452–T455RI.3.9, W.3.7, SL.3.1, SL.3.a, L.3.4.a

	Compare Across Texts
•	Answer the Essential Question
	Inquire
•	Introduce Inquiry Project
•	Read “Relationships in Nature”
•	Generate questions about the topic
•	Apply Academic Vocabulary

	
	
	

	 LESSON 2	
T456–T459RF.3.3, RI.3.4, W.3.7, W.3.8, SL.3.1

	Explore and Plan
•	Informational Writing
•	Read “Coral Reefs: Living Environments”
•	Develop a topic
	Conduct Research
•	Use a Library Database
•	Gather information on research topic

	
	
	

	 LESSON 3	
T460–T463RI.3.5, W.3.10, SL.3.1, SL.3.2, L.3.2.a

	Collaborate and Discuss
•	Read a Student Model
•	Identify features of informational texts
	Refine Research
•	Cite Sources
•	Read “Why We Need Plants”
•	Apply citing sources to article

	
	
	

	 LESSON 4	
T464–T467RI.3.4, RF.3.3, W.3.5, W.3.6, SL.3.2

	Extend Research
•	Investigate a variety of visuals and media
•	Incorporate media into scrapbook
	Collaborate and Discuss
•	Revise & Edit: Clarity
•	Peer review scrapbooks

	
	
	

	 LESSON 5	
T468–T469RF.3.4.a, RI.3.10, W.3.7, W.3.10, SL.3.1

	Celebrate and Reflect
•	Share your scrapbooks
•	Reflect on your project
	Reflect on the Unit
•	Reflect on your goals
•	Reflect on your reading
•	Reflect on your writing
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	Historical Fiction
	
	Historical Fiction
	
	Historical Fiction
	

	
	
	Below Deck: 
A Titanic Story

	
	Granddaddy’s Turn: 
A Journey to the Ballot Box
	
	from Little House on the Prairie and By the Shores of Silver Lake
	

	
	
	
	CCSS
	
	CCSS
	
	CCSS

	READING WORKSHOP
	Minilesson 
Bank
	Primary Sources: Steps on the Moon
	RI.3.10
	Poem: “You Are My Hero”
	RL.3.10
	Infographic: American Heroes
	RI.3.10

	
	
	Historical Fiction: Below Deck: A Titanic Story
	RL.3.10
	Historical Fiction: Granddaddy's Turn: A Journey to the Ballot Box
	RL.3.10
	Historical Fiction: Little House on the Prairie and 
By the Shores of Silver Lake
	RL.3.10

	
	
	Words that Describe Plot and Setting
	L.3.6
	Words that Describe Characters
	L.3.6
	Words that Engage Readers’ Senses
	L.3.6

	
	
	Analyze Plot and Setting
	RL.3.5
	Analyze Characters
	RL.3.3
	Infer Theme
	RL.3.2

	
	
	Correct or Confirm Predictions
	RL.3.10
	Make Connections
	RL.3.10
	Compare and Contrast Texts
	RL.3.9

	
	
	Talk About It: Support an Opinion
	SL.3.1.c
	Write to Sources: Describe Connections to Text
	W.3.10
	Write to Sources Use Text Evidence
	W.3.1

	
	READING-WRITING 
WORKSHOP BRIDGE
	Academic Vocabulary
	Related Words
	L.3.4.d
	Synonyms and Antonyms
	L.3.4.d
	Context Clues
	L.3.4.a

	
	
	Word Study
	Prefixes pre-, dis-, in-, 
im-, non-
	RF.3.3.a
	Abbreviations
	RF.3.3
	Suffixes -ful, -y, -ness
	RF.3.3.a

	
	
	Read Like a Writer
	Explain the Use of Illustrations
	RL.3.7
	Explain the Author’s Message
	RL.3.10
	Describe Hyperbole
	RL.3.4

	
	
	Write for a Reader
	Use Illustrations
	W.3.3
	Emphasize Author’s Message
	W.3.3
	Use Hyperbole
	W.3.3

	WRITING WORKSHOP
	Weekly Focus
	Introduce and Immerse
	Develop Elements
	Develop Structure

	
	Minilesson Bank
	Historical Fiction
	W.3.3
	Compose Characters
	W.3.3.a
	Develop an Introduction
	W.3.3.a

	
	
	Identify Characters and Setting
	W.3.3
	Compose a Setting
	W.3.3
	Draft an Event Sequence
	W.3.3.c

	
	
	Develop Plot
	W.3.3
	Plot: Establish a Problem
	W.3.3.a
	Create an Audio Recording of a Story
	SL.3.4

	
	
	Brainstorm Ideas
	W.3.5
	Plot: Plan a Resolution
	W.3.3
	Compose Dialogue
	W.3.3.b

	
	
	Plan Your Historical Fiction Story
	W.3.5
	Select a Genre
	W.3.4
	Describe Events with Details
	W.3.3

	
	READING-WRITING 
WORKSHOP BRIDGE
	Spelling
	Spell Prefixes pre-, dis-, 
in-, im-, non-
	L.3.2.f
	Spell Abbreviations
	L.3.2.e
	Spell Suffixes -ful, -y, -ness
	L.3.2.e

	
	
	Language and Conventions
	Subject-Verb Agreement
	L.3.1.f
	Edit for Subject-Verb Agreement
	L.3.1.f
	Simple Verb Tenses
	L.3.1.e



 (
UNIT 
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SKILLS OVERVIEW
)
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Savvas is not responsible for any modifications made by end users to the content posted in its original format.
 (
Essential Question
)
What makes a hero?
	WEEK 4
	
	WEEK 5
	

	Biography
	
	Poetry
	

	Mama Miti: Wangari Maathai and the Trees of Kenya
	
	Poems About Heroes


	

	
	CCSS
	
	CCSS

	Time Line: Needing Heroes
	RI.3.10
	Infographic: Acting Heroically
	RI.3.10

	Biography: Mama Miti: Wangari Maathai and the Trees of Kenya
	RI.3.10
	Poetry: “Firefighter Face,” “Miss Stone,” “The Race,” "in daddy’s arms,” “The Wright Brothers”
	RL.3.10

	Words that Make Connections
	L.3.6
	Words that Describe People
	L.3.6

	Analyze Text Structure
	RI.3.3
	Explain Poetic Characteristics
	RL.3.10

	Summarize Informational Text
	RI.3.2
	Monitor Comprehension
	RL.3.10

	Write to Sources: Ask and Answer Questions
	W.3.1
	Talk About It: Ask Pertinent Questions
	SL.3.1.b

	Figurative Language
	RL.3.4
	Parts of Speech
	L.3.1.a

	Vowel Teams
	RF.3.3
	Irregular Plural Nouns
	L.3.1.b

	Analyze Voice and Tone
	RI.3.10
	Analyze Descriptive Language
	RL.3.4

	Use Voice and Tone
	L.3.3.a
	Use Descriptive Language
	L.3.3.a

	Writer’s Craft
	Publish, Celebrate, and Assess

	Edit for Capitalization
	L.3.2
	Edit for Punctuation Marks
	L.3.2

	Add Ideas for Coherence and Clarity
	W.3.3
	Edit for Prepositions and Prepositional Phrases
	L.3.1

	Delete Ideas for Coherence and Clarity
	W.3.3
	Publish and Celebrate
	W.3.3

	Edit for Verbs
	L.3.1.e
	Prepare for Assessment
	W.3.3

	Edit for Subjective, Objective, and Possessive Pronouns
	L.3.1.a
	Assessment
	W.3.3

	Spell Vowel Teams
	L.3.2.f
	Irregular Plural Nouns
	L.3.2.e

	Irregular Verbs
	L.3.1.d
	Pronouns
	L.3.1
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	Be a Hero!


	

	
	CCSS

	Leveled Research Articles
	RI.3.10

	Use Academic Words
	L.3.6

	Explore and Plan: Argumentative Writing
	W.3.5

	Conduct Research: Search Engines
	RI.3.5

	Argumentative Writing: Opinion Speech
	W.3.1

	Refine Research: Paraphrasing and Quoting
	W.3.1

	Extend Research: Add Media
	SL.3.1.b

	Revise for Relevant Details
	W.3.5

	Edit and Peer Review
	W.3.5

	Celebrate and Reflect
	SL.3.4





 (
RL.3.10, RF.3.3.a, W.3.3, SL.3.1.b, L.3.1.f
) (
RF.3.3.a, W.3.3, SL.3.1, SL.3.4, L.3.1, L.3.4.b
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about historical fiction and analyze plot and setting in historical fiction.
	I can develop knowledge about language to make connections between reading fiction and writing historical fiction.
	I can use elements of narrative text to write a historical fiction story.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Primary Source: Weekly Question 
T18–T19
	Listening Comprehension: Read Aloud “Crossing the Rockies” T20–T21
	Historical Fiction T22–T23
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T23
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T32–T55
»	Preview Vocabulary
»	Read: Below Deck: A Titanic Story
	Respond and Analyze T56–T57
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T57
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary Related Words T24–T25
	Word Study: Teach Prefixes pre-, dis-, in-, im-, non- T26–T27
	 READING BRIDGE	
	Word Study: Apply Prefixes pre-, dis-, in-, im-, non- T58–T59
	High-Frequency Words T58

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T31
	Strategy, Intervention, and On-Level/
Advanced Activities T30
	ELL Targeted Support T30
	Conferring T31
INDEPENDENT/COLLABORATIVE
	Independent Reading T31
	Literacy Activities T31
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T31 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T61
	Strategy and Intervention Activities T60
	Fluency T60
	ELL Targeted Support T60
	Conferring T61
INDEPENDENT/COLLABORATIVE
	Independent Reading T61
	Literacy Activities T61
	Collaboration T61

	
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T334–T335
»	Historical Fiction
»	Share Back
INDEPENDENT WRITING
	Writing Product T335
	Conferences T332
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T338–T339
»	Identify Characters and Setting
»	Share Back
INDEPENDENT WRITING
	Writing Product T339
	Conferences T332

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Prefixes pre-, dis-, in-, 
im-, non- T336
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T336
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Main Verbs and Helping 
Verbs T337

	 WRITING BRIDGE	
	Spelling: Prefixes pre-, dis-, in-, im-, 
non- T340
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Subject-Verb Agreement T341
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 (
RL.3.5, W.3.3, W.3.5, SL.3.1, SL.3.4, L.3.1.i
) (
RL.3.7, RL.3.10, W.3.3, SL.3.4, L.3.1.f
) (
RL.3.5, RL.3.7, RL.3.10, W.3.3, SL.3.1.d, L.3.1.f
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Plot and Setting T62–T63
»	Close Read: Below Deck: A Titanic Story
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T63
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Confirm or Correct Predictions T70–T71
»	Close Read: Below Deck: A Titanic Story
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T71
	 LESSON 5 
 READING WORKSHOP	
GENRE & THEME
	Reflect and Share T78–T79
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T79
»	Weekly Question 

	 READING BRIDGE	
	Read Like a Writer: Explain the Use of Illustrations T64–T65
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Prefixes 
pre-, dis-, in-, im-, non- T66–T67
	 READING BRIDGE	
	Write for a Reader: Use Illustrations 
T72–T73
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: 
Contractions T74–T75
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Prefixes pre-, dis-, 
in-, im-, non- T80–T81
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T80

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T69
	Strategy and Intervention Activities T68
	Fluency T68
	ELL Targeted Support T68
	Conferring T69
INDEPENDENT/COLLABORATIVE
	Independent Reading T69
	Literacy Activities T69
	Partner Reading T69
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T77
	Strategy and Intervention Activities T76
	Fluency T76
	ELL Targeted Support T76
	Conferring T77
INDEPENDENT/COLLABORATIVE
	Independent Reading T77
	Literacy Activities T77

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T83
	Strategy, Intervention, and On-Level/
Advanced Activities T82
	ELL Targeted Support T82
	Conferring T83
INDEPENDENT/COLLABORATIVE
	Independent Reading T83
	Literacy Activities T83
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T83 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T342–T343
»	Develop Plot
»	Share Back
INDEPENDENT WRITING
	Writing Product T343
	Conferences T332
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T346–T347
»	Brainstorm Ideas
»	Share Back
INDEPENDENT WRITING
	Writing Product T347
	Conferences T332
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T350
»	Plan Your Historical Fiction Story
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T351 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T332

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Prefixes 
pre-, dis-, in-, im-, non- T344
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Language and Conventions: Teach Subject-Verb Agreement T345


	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Contractions 
T348
	Language and Conventions: Practice Subject-Verb Agreement T349


	 WRITING BRIDGE	
	Spelling: Prefixes pre-, dis-, in-, im-, 
non- T352
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T352
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Standards Practice T353






 (
RL.3.1, RF.3.4.a, W.3.3, SL.3.1.a, L.3.1.f, L.3.1.i
) (
RL.3.1, RL.3.3, W.3.3.a, SL.3.1.d, L.3.4.d, L.3.5
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about historical fiction and analyze plot and setting in historical fiction.
	I can develop knowledge about language to make connections between reading fiction and writing historical fiction.
	I can use elements of narrative text to write a historical fiction story.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Poem: Weekly Question T88–T89
	Listening Comprehension: Read Aloud: “Heart Mountain” T90–T91
	Historical Fiction T92–T93
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T93
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T102–T115
»	Preview Vocabulary
»	Read: Granddaddy’s Turn: A Journey to the Ballot Box
	Respond and Analyze T116–T117
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T117
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Synonyms and Antonyms T94–T95
	Word Study: Teach Abbreviations 
T96–T97
	 READING BRIDGE	
	Word Study: Apply Abbreviations 
T118–T119
	High-Frequency Words T118

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T100–T101
	Strategy, Intervention, and On-Level/
Advanced Activities T100
	ELL Targeted Support T100
	Conferring T101
INDEPENDENT/COLLABORATIVE
	Independent Reading T101
	Literacy Activities T101
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T101 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T120–T121
	Strategy and Intervention Activities T120
	Fluency T120
	ELL Targeted Support T120
	Conferring T121
INDEPENDENT/COLLABORATIVE
	Independent Reading T121
	Literacy Activities T121
	Partner Reading T121

	
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction Story T358–T359
»	Compose Characters
»	Share Back
INDEPENDENT WRITING
	Historical Fiction Story T359
	Conferences T356
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction Story T362–T363
»	Compose a Setting
»	Share Back
INDEPENDENT WRITING
	Historical Fiction Story T363
	Conferences T356

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Abbreviations T360
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T360
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Subject-Verb Agreement T361


	 WRITING BRIDGE	
	Spelling: Teach Abbreviations T364
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Edit for Subject-Verb Agreement T365
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 (
RL.3.1, RF.3.3, W.3.5, SL.3.4, SL.3.6, L.3.1.f
) (
RL.3.2, RF.3.3.a, W.3.3.a, W.3.3.d, L.3.1.f
) (
RL.3.3, RF.3.4.a, W.3.3, W.3.3.a, SL.3.1.a, L.3.1.f
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Characters T122–T123
»	Close Read: Granddaddy’s Turn: 
A Journey to the Ballot Box
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T123
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Make Connections T130–T131
»	Close Read: Granddaddy’s Turn: 
A Journey to the Ballot Box
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T131
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T138–T139
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T139
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Explain the Author’s Message T124–T125
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: 
Abbreviations T126–T127
	 READING BRIDGE	
	Write for a Reader: Emphasize Author’s Message T132–T133
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Prefixes 
pre-, dis-, in-, im-, non- T134–T135
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Abbreviations 
T140–T141
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T140

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T128–T129
	Strategy and Intervention Activities T128
	Fluency 128
	ELL Targeted Support 128
	Conferring 129
INDEPENDENT/COLLABORATIVE
	Independent Reading T129
	Literacy Activities T129
	Partner Reading T129
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T136–T137
	Strategy and Intervention Activities T136
	Fluency T136
	ELL Targeted Support T136
	Conferring T137
INDEPENDENT/COLLABORATIVE
	Independent Reading T137
	Literacy Activities T137
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T142–T143
	Strategy, Intervention, and On-Level/
Advanced Activities T142
	ELL Targeted Support T142
	Conferring T143
INDEPENDENT/COLLABORATIVE
	Independent Reading T143
	Literacy Activities T143
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	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction Story T366–T367
»	Plot: Establish a Problem
»	Share Back
INDEPENDENT WRITING
	Historical Fiction Story T367
	Conferences T356
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction Story T370–T371
»	Plot: Plan a Resolution
»	Share Back
INDEPENDENT WRITING
	Historical Fiction Story T371
	Conferences T356
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction Story T374–T375
»	Select a Genre
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T374–T375 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T356

	 WRITING BRIDGE	
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	Spelling: More Practice: 
Abbreviations T368
	Language and Conventions: Teach Edit for Subject-Verb Agreement T369


	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Prefixes 
pre-, dis-, in-, im-, non- T372
	Language and Conventions: Practice Edit for Subject-Verb Agreement T373


	 WRITING BRIDGE	
	Spelling: Abbreviations T376
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Standards Practice T377






 (
RF.3.3.a, W.3.3.c, W.3.4, L.3.1.e, L.3.2.e, L.3.2.f
) (
RF.3.3.a, W.3.3.a, W.3.4, SL.3.2, L.3.4.a, L.3.5.a
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about historical fiction and infer themes in historical fiction.
	I can develop knowledge about language to make connections between reading fiction and writing historical fiction.
	I can use elements of narrative text to write a historical fiction story.
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[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic
	Weekly Question T148–T149
	Listening Comprehension: Read Aloud “Everyday Superheroes” T150–T151
	Historical Fiction T152–T153
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T153
	 LESSON 2 
 READING WORKSHOP	
GENRE & THEME
	Introduce the Texts T162–T177
»	Preview Vocabulary
»	Read and Compare Texts
	Respond and Analyze T178–T179
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T179
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Context Clues T154–T155
	Word Study: Teach Suffixes -ful, -y, 
-ness T156–T157
	 READING BRIDGE	
	Word Study: Apply Suffixes -ful, -y, 
-ness T180–T181
	High-Frequency Words T180

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T160–T161
	Strategy, Intervention, and On-Level/
Advanced Activities T160
	ELL Targeted Support T160
	Conferring T161
INDEPENDENT/COLLABORATIVE
	Independent Reading T161
	Literacy Activities T161
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T161 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T182–T183
	Strategy and Intervention Activities T182
	Fluency T182
	ELL Targeted Support T182
	Conferring T183
INDEPENDENT/COLLABORATIVE
	Independent Reading T183
	Literacy Activities T183


	
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T382–T383
»	Develop an Introduction
»	Share Back
INDEPENDENT WRITING
	Historical Fiction T383
	Conferences T380
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T386–T387
»	Develop an Event Sequence
»	Share Back
INDEPENDENT WRITING
	Historical Fiction T387
	Conferences T380

	
	 WRITING BRIDGE	
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	Spelling: Suffixes -ful, -y, -ness T384
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	Language and Conventions: Spiral Review: Subject-Verb Agreement T385


	 WRITING BRIDGE	
	Spelling: Teach Suffixes -ful, -y, -ness T388
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) (
RL.3.9, W.3.3.b, W.3.4, SL.3.1.b, L.3.1.e, L.3.2.c
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)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Infer Theme T184–T185
»	Close Read: Little House on the Prairie and By the Shores of Silver Lake
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T185
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Compare and Contrast Texts 
T192–T193
»	Close Read: Little House on the Prairie and By the Shores of Silver Lake
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T193
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T200–T201
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T201
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Describe Hyperbole T186–T187
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Suffixes 
-ful, -y, -ness T188–T189
	 READING BRIDGE	
	Write for a Reader: Use Hyperbole 
T194–T195
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: 
Abbreviations T196–T197
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Suffixes -ful, -y, -ness 
T202–T203
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T202

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T190–T191
	Strategy and Intervention Activities T190
	Fluency T190
	ELL Targeted Support T190
	Conferring T191
INDEPENDENT/COLLABORATIVE
	Independent Reading T191
	Literacy Activities T191
	Partner Reading T191
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T198–T199
	Strategy and Intervention Activities T198
	Fluency T198
	ELL Targeted Support T198
	Conferring T199
INDEPENDENT/COLLABORATIVE
	Independent Reading T199
	Literacy Activities T199
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T204–T205
	Strategy, Intervention, and On-Level/
Advanced Activities T204
	ELL Targeted Support T204
	Conferring T205
INDEPENDENT/COLLABORATIVE
	Independent Reading T205
	Literacy Activities T205
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	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T390–T391
»	Create An Audio Recording of a Story
»	Share Back
INDEPENDENT WRITING
	Historical Fiction T391
	Conferences T380
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T394–T395
»	Compose Dialogue
»	Share Back
INDEPENDENT WRITING
	Historical Fiction T395
	Conferences T380
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T398–T399
»	Describe Events with Details
»	Share Back
INDEPENDENT WRITING
	Select a Genre T398
	Conferences T380

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Suffixes -ful, 
-y, -ness T392
	Language and Conventions: Teach Simple Verb Tenses T393


	 WRITING BRIDGE	
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	Spelling: Spiral Review: Abbreviations 
T396
	Language and Conventions: Practice Simple Verb Tenses T397


	 WRITING BRIDGE	
	Spelling: Suffixes -ful, -y, -ness T400
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 (
RI.3.10, RF.3.3, RF.3.4.b, W.3.3.a, SL.3.1, L.3.1.d
) (
RL.3.4, RF.3.3, RF.3.4, SL.3.1.b, L.3.2, L.3.5.a
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about themes concerning heroes and analyze text structure in a biography.
	I can develop knowledge about language to make connections between reading fiction and writing.
	I can use elements of narrative text to write a historical fiction story.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Time Line Weekly Question T210–T211
	Listening Comprehension: Read Aloud: “Brave–Courageous” T212–T213
	Biography T214–T215
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T215
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T224–T237
»	Preview Vocabulary
»	Read: Mama Miti: Wangari Maathai and the Trees of Kenya
	Respond and Analyze T238–T239
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T239
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Figurative Language T216–T217
	Word Study: Teach Vowel Teams 
oo, ew, ue, ui, eu T218–T219
	 READING BRIDGE	
	Word Study: Apply Vowel Teams oo, ew, ue, ui, eu T240–T241
	High-Frequency Words T240

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T222
	Strategy, Intervention, and On-Level/
Advanced Activities T221
	ELL Targeted Support T221
	Conferring T222
INDEPENDENT/COLLABORATIVE
	Independent Reading T222
	Literacy Activities T222
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	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T243
	Strategy and Intervention Activities T242
	Fluency 242
	ELL Targeted Support 242
	Conferring 243
INDEPENDENT/COLLABORATIVE
	Independent Reading 243
	Literacy Activities 243
	Collaboration 243

	
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T406–T407
»	Edit for Capitalization
»	Share Back
INDEPENDENT WRITING
	Historical Fiction T407
	Conferences T404
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T410–T411
»	Add Ideas for Coherence and Clarity
»	Share Back
INDEPENDENT WRITING
	Historical Fiction T411
	Conferences T404

	
	 WRITING BRIDGE	
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	Spelling: Spell Vowel Teams oo, ew, 
ue, ui, eu T408
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	Language and Conventions: Spiral Review: Simple Verb Tenses T409

	 WRITING BRIDGE	
	Spelling: Teach Vowel Teams oo, ew, ue, ui, eu T412
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Text Structure T244–T245
»	Close Read: Mama Miti: Wangari Maathai and the Trees of Kenya
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T245
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Summarize Informational Text 
T252–T253
»	Close Read: Mama Miti: Wangari Maathai and the Trees of Kenya
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T253
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T260–T261
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T261
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Voice and Tone T246–T247
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Vowel 
Teams oo, ew, ue, ui, eu T248–T249
	 READING BRIDGE	
	Write for a Reader: Use Voice and Tone T254–T255
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Suffixes 
-ful, -y, -ness T256–T257
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Vowel Teams oo, ew, 
ue, ui, eu T262–T263
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T262

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T251
	Strategy and Intervention Activities T250
	Fluency T250
	ELL Targeted Support T250
	Conferring T251
INDEPENDENT/COLLABORATIVE
	Independent Reading T251
	Literacy Activities T251
	Partner Reading T251
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T259
	Strategy and Intervention Activities T258
	Fluency T258
	ELL Targeted Support T258
	Conferring T259
INDEPENDENT/COLLABORATIVE
	Independent Reading T259
	Literacy Activities T259
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T265
	Strategy, Intervention, and On-Level/
Advanced Activities T264
	Fluency T264
	ELL Targeted Support T264
	Conferring T265
INDEPENDENT/COLLABORATIVE
	Independent Reading T265
	Literacy Activities T265
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T265 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T414–T415
»	Delete Ideas for Coherence and Clarity
»	Share Back
INDEPENDENT WRITING
	Historical Fiction T415
	Conferences T404
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T418–T419
»	Edit for Verbs
»	Share Back
INDEPENDENT WRITING
	Historical Fiction T419
	Conferences T404
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T422–T423
»	Edit for Subjective, Objective, and Possessive Pronouns
»	Share Back
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T422–T423 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T404

	 WRITING BRIDGE	
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	Spelling: More Practice: Vowel Teams 
oo, ew, ue, ui, eu T416
	Language and Conventions: Teach Irregular Verbs T417

	 WRITING BRIDGE	
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	Spelling: Spiral Review: Suffixes 
-ful, -y, -ness T420
	Language and Conventions: Practice Irregular Verbs T421


	 WRITING BRIDGE	
	Spelling: Vowel Teams oo, ew, ue, 
ui, eu T424
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 (
RL.3.10, RF.3.4.b, W.3.5, L.3.1.a, L.3.5
) (
RF.3.4.b, RL.3.10, W.3.5, L.3.1.a, L.3.2.d
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about themes concerning heroes and explain poetic elements in poetry.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of narrative text to write a historical fiction story.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Writing Workshop Assessment
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
	Test Banks
	Writing Workshop Performance-Based Assessment
 (
Materials
Turn the page for a list of materials that will support planning for the week.
)
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic T270–T271
	Listening Comprehension: Read Aloud “There for Me” T272–T273
	Poetry T274–T275
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T275 
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T284–T295
»	Preview Vocabulary
»	Read: “Firefighter Face,” “Miss Stone,” “The Race,” “in daddy’s arms,” “The Wright Brothers”
	Respond and Analyze T296–T297
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T297
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Parts of Speech T276–T277
	Word Study: Teach Irregular Plural Nouns T278–T279
	 READING BRIDGE	
	Word Study: Apply Irregular Plural Nouns T298–T299
	High-Frequency Words T298

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T282–T283
	Strategy, Intervention, and On-Level/
Advanced Activities T282
	ELL Targeted Support T282
	Conferring T283
INDEPENDENT/COLLABORATIVE
	Independent Reading T283
	Literacy Activities T283
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T283 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T300–T301
	Strategy and Intervention Activities T300
	Fluency T300
	ELL Targeted Support T300
	Conferring T301
INDEPENDENT/COLLABORATIVE
	Independent Reading T301
	Literacy Activities T301

	
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T430–T431
»	Edit for Punctuation Marks
»	Share Back
INDEPENDENT WRITING
	Historical Fiction T431
	Conferences T428
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T434–T435
»	Edit for Prepositions and Prepositional Phrases
INDEPENDENT WRITING
	Historical Fiction T435
	Conferences T428

	
	 WRITING BRIDGE	
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	Spelling: Irregular Plural Nouns 
T432
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[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Irregular Verbs T433


	 WRITING BRIDGE	
	Spelling: Teach Irregular Plural Nouns T436
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Explain Poetic Characteristics 
T302–T303
»	Close Read: “Firefighter Face,” “Miss Stone,” The Race,” “in daddy’s arms,” “The Wright Brothers”
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T303
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Monitor Comprehension T310–T311
»	Close Read: “Firefighter Face,” “Miss Stone,” “The Race,” “in daddy’s arms,” “The Wright Brothers”
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T311
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T318–T319
»	Talk About It
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»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Descriptive Language T304–T305
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	 READING BRIDGE	
	Write for a Reader: Use Descriptive Language T312–T313
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	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T308–T309
	Strategy and Intervention Activities T308
	Fluency T308
	ELL Targeted Support T308
	Conferring T309
INDEPENDENT/COLLABORATIVE
	Independent Reading T309
	Literacy Activities T309
	Partner Reading T309
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T316–T317
	Strategy and Intervention Activities T316
	Fluency T316
	ELL Targeted Support T316
	Conferring T317
INDEPENDENT/COLLABORATIVE
	Independent Reading T317
	Literacy Activities T317
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T322–T323
	Strategy, Intervention, and On-Level/
Advanced Activities T322
	ELL Targeted Support T322
	Conferring T323
INDEPENDENT/COLLABORATIVE
	Independent Reading T323
	Literacy Activities T323
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	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T438–T439
»	Publish and Celebrate
»	Share Back
INDEPENDENT WRITING
	Historical Fiction T439
	Conferences T428
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T442–T443
»	Prepare for Assessment
»	Share Back
INDEPENDENT WRITING
	Historical Fiction T443
	Conferences T428
	 WRITING WORKSHOP	
MINILESSON
	Historical Fiction T446–T447
»	Assessment
INDEPENDENT WRITING
	Assessment T446
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	 WRITING BRIDGE	
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 PROJECT FOCUS 	This week students will
• write an opinion speech about why it is important to take advantage of heroic opportunities.
• research evidence that supports their claim and persuades 
their audience.

	 LESSON 1	
T454–T457RI.3.2, W.3.1.b, W.3.4, W.3.7, SL.3.1, SL.3.1.c

	Compare Across Texts
•	Answer the Essential Question
	Inquire
•	Introduce Inquiry Project
•	Read “Heroes Aren’t Just for Comic Books”
•	Generate questions
•	Apply Academic Vocabulary

	
	
	

	 LESSON 2	
T458–T461RI.3.1, RI.3.5, W.3.7, W.3.8, W.3.10, SL.3.1

	Explore and Plan
•	Argumentative Writing
•	Read: “I’m a Volunteer!”
•	Apply characteristics of text
	Conduct Research
•	Using a search engine
•	Identify keywords to research

	
	
	

	 LESSON 3	
T462–T465RI.3.2, W.3.1, W.3.1.d, W.3.7, SL.3.1, SL.3.1.b

	Collaborate and Discuss
•	Read a Student Mode
•	Identify features of argumentative texts
	Refine Research
•	Paraphrasing and Quoting
•	Read “A Helping Hand”
•	Apply paraphrasing and quoting 
to article

	
	
	

	 LESSON 4	
T466–T469RI.3.7, W.3.8, W.3.10, SL.3.1, SL.3.1.b, L.3.1

	Extend Research
•	Investigate a variety of media
•	Incorporate media into opinion speech
	Collaborate and Discuss
•	Revise & Edit: Relevant Details
•	Peer review opinion speeches

	
	
	

	 LESSON 5	
T470–T471RI.3.2, W.3.5, W.3.8, SL.3.1.c, SL.3.4

	Celebrate and Reflect
•	Present your opinion speeches
•	Reflect on your project
	Reflect on the Unit
•	Reflect on your goals
•	Reflect on your reading
•	Reflect on your writing
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Douglass
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	READING WORKSHOP
	Minilesson 
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	Primary Source: Daniel Burnham
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	Primary Source: Sojourner Truth
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	Infographic: Think Big
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	Word Study
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	RF.3.3
	VCCCV Pattern
	RF.3.3
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	RF.3.3.b

	
	
	Read Like a Writer
	Explain the Use of Descriptive Language
	RI.3.10
	Analyze Graphic Features
	RI.3.7
	Explain the Use of Tone and Voice
	RI.3.10

	
	
	Write for a Reader
	Use Descriptive Language
	L.3.3.a
	Use Graphic Features
	W.3.2
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	L.3.3.a

	WRITING WORKSHOP
	Weekly Focus
	Introduce and Immerse
	Develop Elements
	Develop Structure

	
	Minilesson Bank
	Opinion Essay
	W.3.1
	Develop the Topic
	W.3.1
	Compose an Introduction
	W.3.1.a

	
	
	Topic
	W.3.1
	Develop an Opinion
	W.3.1.a
	Organize Supporting Reasons
	W.3.1.a

	
	
	Point of View and Reasons
	W.3.1
	Distinguish Between Fact and Opinion
	W.3.1
	Organize Supporting Facts
	W.3.1.a

	
	
	Brainstorm Topics and Focus on Opinion
	W.3.1
	Develop Reasons
	W.3.1.b
	Compose a Conclusion
	W.3.1.d

	
	
	Plan Your Opinion Essay
	W.3.1.b
	Develop Supporting Facts
	W.3.1.b
	Use Technology
	W.3.6

	
	READING-WRITING 
WORKSHOP BRIDGE
	Spelling
	Spell r-Controlled Vowels ir, er, ur, ear
	L.3.2.f
	Spell Words with the VCCCV Pattern
	L.3.2.f
	Spell Words with -able, 
-ible, -ation
	L.3.2.e
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	Possessive Pronouns
	L.3.1.a
	Contractions
	L.3.1
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	Narrative Nonfiction
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	Green City
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	CCSS
	
	CCSS

	Time Line: Changing the World With One Idea
	RI.3.10
	Poem: Thank You for Understanding
	RL.3.10

	Narrative Nonfiction: 
Green City
	RI.3.10
	Drama: Grace and Grandma
	RL.3.10

	Words That Help Readers Connect Events
	L.3.6
	Precise Words
	L.3.5

	Distinguish Viewpoint
	RI.3.6
	Identify Play Elements
	RL.3.5

	Make Connections
	RI.3.10
	Monitor Comprehension
	RL.3.10

	Write to Sources: Support Comparison or Opinion with Text Evidence
	W.3.1
	Talk About It: Use Text Evidence to Support Opinions
	SL.3.1.a

	Analogies
	L.3.5.b
	Parts of Speech
	L.3.1.a

	Homographs
	RF.3.3.d
	Homophones
	RF.3.3.d

	Analyze Text Structure
	RI.3.10
	Explain Author’s Message
	RL.3.2

	Use Text Structure
	W.3.3.c
	Share a Message
	W.3.3

	Writer’s Craft
	Publish, Celebrate, and Assess

	Revise Drafts by Adding Linking Words
	W.3.1.c
	Use Technology to Publish Written Work
	W.3.6

	Revise Drafts by Adding Details
	W.3.1.b
	Edit for Spelling
	L.3.2

	Edit for Capitalization
	L.3.2
	Publish and Celebrate
	W.3.1

	Peer Edit
	W.3.5
	Prepare for Assessment
	W.3.1

	Use Peer and Teacher Suggestions
	W.3.5
	Assessment
	W.3.1

	Words That Are Homographs
	L.3.2.e
	Spell Homophones
	L.3.2.e

	Comparing with Adjectives
	L.3.1.g
	Adverbs
	L.3.1.a
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Past and Present
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	Leveled Research Articles
	RI.3.10

	Use Academic Words
	L.3.6

	Explore and Plan: Informational Writing
	W.3.5

	Conduct Research: Library of Congress
	RI.3.5

	Informational Writing: Poster
	W.3.2

	Refine Research: Identifying Sources
	W.3.7

	Extend Research: Include Images
	W.3.7

	Revise for Clarity and Coherence
	W.3.5

	Edit and Peer Review
	W.3.5

	Celebrate and Reflect
	SL.3.5





 (
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) (
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)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about biography and analyze text structure in a biography.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of opinion writing to write an opinion essay.
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	Practice Tests
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Materials
Turn the page for a list of materials that will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Primary Source: Weekly Question 
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	Biography T22–T23
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	Guided Reading/Leveled Readers 
T30–T31
	Strategy, Intervention, and On-Level/
Advanced Activities T30
	ELL Targeted Support T30
	Conferring T31
INDEPENDENT/COLLABORATIVE
	Independent Reading T31
	Literacy Activities T31
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	Guided Reading/Leveled Readers 
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	Strategy and Intervention Activities T54
	Fluency T54
	ELL Targeted Support T54
	Conferring T55
INDEPENDENT/COLLABORATIVE
	Independent Reading T55
	Literacy Activities T55
	Collaboration T55

	
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T340–T341
»	Opinion Essay
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T341
	Conferences T338
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T344–T345
»	Topic
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T345
	Conferences T338
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RF.3.3, W.3.1, W.3.5, SL.3.1, SL.3.3, L.3.2.d
) (
RF.3.4.a, RF.3.4.b, RI.3.3, W.3.5, SL.3.1.a, L.3.2.d
) (
RI.3.3, RI.3.8, W.3.1.b, SL.3.1, L.3.2.d
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Text Structure T56–T57
»	Close Read: The House That Jane Built
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	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Correct or Confirm Predictions T64–T65
»	Close Read: The House That Jane Built
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	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T72–T73
»	Talk About It
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	Weekly Question


	 READING BRIDGE	
	Read Like a Writer: Explain the Use of Descriptive Language T58–T59
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	Word Study: More Practice: 
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T60–T61
	 READING BRIDGE	
	Write for a Reader: Use Descriptive Language T66–T67
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	Word Study: Spiral Review: 
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	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T62–T63
	Strategy and Intervention Activities T62
	Fluency T62
	ELL Targeted Support T62
	Conferring T63
INDEPENDENT/COLLABORATIVE
	Independent Reading T63
	Literacy Activities T63
	Partner Reading T63
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T70–T71
	Strategy and Intervention Activities T70
	Fluency T70
	ELL Targeted Support T70
	Conferring T71
INDEPENDENT/COLLABORATIVE
	Independent Reading T71
	Literacy Activities T71

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T76–T77
	Strategy, Intervention, and On-Level/
Advanced Activities T76
	ELL Targeted Support T76
	Conferring T77
INDEPENDENT/COLLABORATIVE
	Independent Reading T77
	Literacy Activities T77
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	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T348–T349
»	Point of View and Reasons
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T349
	Conferences T338
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T352–T353
»	Brainstorm Topics and Focus on Opinion
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T353
	Conferences T338
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T356
»	Plan Your Opinion Essay
»	Share Back
INDEPENDENT WRITING
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) (
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)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about biography and identify the main idea and key details 
in a biography.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of opinion writing 
to write an opinion essay.
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Materials
Turn the page for a list of materials that will support planning for the week.
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T112–T113
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	 SMALL GROUP/INDEPENDENT	
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	Guided Reading/Leveled Readers 
T94–T95
	Strategy, Intervention, and On-Level/
Advanced Activities T94
	ELL Targeted Support T94
	Conferring T95
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	Independent Reading T95
	Literacy Activities T95
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	Fluency T114
	ELL Targeted Support T114
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	Literacy Activities T115
	Partner Reading T115

	
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T364–T365
»	Develop the Topic
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T365
	Conferences T362
	 WRITING WORKSHOP	
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	Opinion Essay T368–T369
»	Develop an Opinion
»	Share Back
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	Opinion Essay T369
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	 LESSON 3 
 READING WORKSHOP	
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	Identify Main Idea and Key Details 
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»	Close Read: Frederick Douglass
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	Reflect and Share T132–T133
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T133
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Graphic Features T118–T119
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: 
VCCCV Pattern T120–T121
	 READING BRIDGE	
	Write for a Reader: Use Graphic Features T126–T127
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: 
r-Controlled Vowels ir, er, ur, ear 
T128–T129
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: VCCCV Pattern 
T134–T135
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T134

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T122–T123
	Strategy and Intervention Activities T122
	Fluency T122
	ELL Targeted Support T122
	Conferring T123
INDEPENDENT/COLLABORATIVE
	Independent Reading T123
	Literacy Activities T123
	Partner Reading T123
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T130–T131
	Strategy and Intervention Activities T130
	Fluency T130
	ELL Targeted Support T130
	Conferring T131
INDEPENDENT/COLLABORATIVE
	Independent Reading T131
	Literacy Activities T131
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T136–T137
	Strategy, Intervention, and On-Level/
Advanced Activities T136
	ELL Targeted Support T136
	Conferring T137
INDEPENDENT/COLLABORATIVE
	Independent Reading T137
	Literacy Activities T137
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T137 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T372–T373
»	Distinguish Between Fact and Opinion
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T373
	Conferences T362
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T376–T377
»	Develop Reasons
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T377
	Conferences T362
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T380
»	Develop Supporting Facts
»	Share Back
INDEPENDENT WRITING
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	Conferences T362

	 WRITING BRIDGE	
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	Spelling: More Practice: Words with 
the VCCCV Pattern T374
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	 WRITING BRIDGE	
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	Spelling: Spiral Review: Words with 
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	Language and Conventions: Practice Contractions T379


	 WRITING BRIDGE	
	Spelling: VCCCV Words T382
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RF.3.3.b, W.3.1.a, W.3.1.b, SL.3.1, L.3.1, L.3.2.e
) (
RF.3.4.b, RF.3.4.c, W.3.4, SL.3.1.a, L.3.4.a, L.3.5.a
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about biography and explain the author's purpose in a biography.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of opinion writing to write an opinion essay.
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[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question 
T142–T143
	Listening Comprehension: Read 
Aloud “George Washington Carver” 
T144–T145
	Biography T146–T147
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T147
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T156–T173
»	Preview Vocabulary
»	Read: Milton Hershey: Chocolate King, Town Builder
	Respond and Analyze T174–T175
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T175
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Context Clues T148–T149
	Word Study: Teach Latin Suffixes 
T150–T151
	 READING BRIDGE	
	Word Study: Apply Latin Suffixes 
T176–T177
	High-Frequency Words T176

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T154–T155
	Strategy, Intervention, and On-Level/
Advanced Activities T154
	ELL Targeted Support T154
	Conferring T155
INDEPENDENT/COLLABORATIVE
	Independent Reading T155
	Literacy Activities T155
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T155 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T178–T179
	Strategy and Intervention Activities T178
	Fluency T178
	ELL Targeted Support T178
	Conferring T179
INDEPENDENT/COLLABORATIVE
	Independent Reading T179
	Literacy Activities T179
	Collaboration T179

	
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T388–T389
»	Compose an Introduction
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T389
	Conferences T386
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T392–T393
»	Organize Supporting Reasons
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T393
	Conferences T386

	
	 WRITING BRIDGE	
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-ible, -ation T3904
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	 WRITING BRIDGE	
	Spelling: Teach Words with -able, -ible, 
-ation T394
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Explain Author’s Purpose T180–T181
»	Close Read: Milton Hershey
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T181
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Ask and Answer Questions T188–T189
»	Close Read: Milton Hershey
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T189
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T196–T197
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T197
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Explain the Use of Tone and Voice T182–T183
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Suffixes T184–T185
	 READING BRIDGE	
	Write for a Reader: Use Tone and 
Voice T190–T191
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	 READING BRIDGE	
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	Word Study: Latin Suffixes 
T198–T199
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	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T186–T187
	Strategy and Intervention Activities T186
	Fluency T186
	ELL Targeted Support T186
	Conferring T187
INDEPENDENT/COLLABORATIVE
	Independent Reading T187
	Literacy Activities T187
	Partner Reading T187
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T194–T195
	Strategy and Intervention Activities T194
	Fluency T194
	ELL Targeted Support T194
	Conferring T195
INDEPENDENT/COLLABORATIVE
	Independent Reading T195
	Literacy Activities T195
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T200–T201
	Strategy, Intervention, and On-Level/
Advanced Activities T200
	ELL Targeted Support T200
	Conferring T201
INDEPENDENT/COLLABORATIVE
	Independent Reading T201
	Literacy Activities T201
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	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T396–T397
»	Organize Supporting Facts
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T397
	Conferences T386
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T400–T401
»	Compose a Conclusion
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T401
	Conferences T380
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T404
»	Use Technology
»	Share Back
INDEPENDENT WRITING
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	 WRITING BRIDGE	
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	Language and Conventions: Teach Prepositions and Prepositional Phrases T399

	 WRITING BRIDGE	
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	Spelling: Spiral Review: VCCCV 
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	Language and Conventions: Practice Prepositions and Prepositional Phrases T403

	 WRITING BRIDGE	
	Spelling: Words with -able, -ible, -ation T406
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	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about themes concerning events by distinguishing viewpoint in narrative nonfiction.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of opinion writing 
to write an opinion essay.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Time Line: Weekly Question 
T206–T207
	Listening Comprehension: Read Aloud “Never a Quitter” T208–T209
	Narrative Nonfiction: Biographies and Autobiographies T210–T211
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T211
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T220–T239
»	Preview Vocabulary
»	Read: Green City
	Respond and Analyze T240–T241
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T241
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Analogies 
T212–T213
	Word Study: Teach Homographs 
T214–T215
	 READING BRIDGE	
	Word Study: Apply Homographs 
T242–T243
	High-Frequency Words T242

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T218–T219
	Strategy, Intervention, and On-Level/
Advanced Activities T218
	ELL Targeted Support T218
	Conferring T219
INDEPENDENT/COLLABORATIVE
	Independent Reading T219
	Literacy Activities T219
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	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T244–T245
	Strategy and Intervention Activities 
T244
	Fluency T244
	ELL Targeted Support T244
	Conferring T245
INDEPENDENT/COLLABORATIVE
	Independent Reading T245
	Literacy Activities T245
	Collaboration T245

	
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T412–T413
»	Revise Drafts by Adding Linking Words
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T413
	Conferences T410
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T416–T417
»	Revise Drafts by Adding Details
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T417
	Conferences T410

	
	 WRITING BRIDGE	
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	Spelling: Teach Words That Are Homographs T418
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Distinguish Viewpoint T246–T247
»	Close Read: Green City
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T247
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Make Connections T254–T255
»	Close Read: Green City
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	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T262–T263
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T263
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Text Structure T248–T249
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: 
Homographs T250–T251
	 READING BRIDGE	
	Write for a Reader: Use Text Structure T256–T257
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	 READING BRIDGE	
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	Word Study: Homographs 
T264–T265
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T264

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T252–T253
	Strategy and Intervention Activities T252
	Fluency T252
	ELL Targeted Support T252
	Conferring T253
INDEPENDENT/COLLABORATIVE
	Independent Reading T253
	Literacy Activities T253
	Partner Reading T253
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T260–T261
	Strategy and Intervention Activities T260
	Fluency T260
	ELL Targeted Support T260
	Conferring T261
INDEPENDENT/COLLABORATIVE
	Independent Reading T261
	Literacy Activities T261
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T266–T267
	Strategy, Intervention, and On-Level/
Advanced Activities T266
	ELL Targeted Support T266
	Conferring T267
INDEPENDENT/COLLABORATIVE
	Independent Reading T267
	Literacy Activities T267
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	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T420–T421
»	Edit for Capitalization
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T421
	Conferences T410
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T424–T425
»	Peer Edit
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T425
	Conferences T410
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T428
»	Use Peer and Teacher Suggestions
»	Share Back
INDEPENDENT WRITING
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	 WRITING BRIDGE	
	Spelling: Words That Are Homographs T430
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RL.3.1, RL.3.4, W.3.6, SL.3.1.d, L.3.1.g
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about themes concerning events by reading a text that helps me identify elements in a drama.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of opinion writing 
to write an opinion essay.
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[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Writing Workshop Assessment
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
	Test Banks
	Writing Workshop Performance-Based Assessment
 (
Materials
Turn the page for a list of materials that will support planning for the week.
)
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Poems: Weekly Question T272–T273
	Listening Comprehension: Read Aloud “The Comforts of Home” T274–T275
	Drama T276–T277
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T277
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T286–T301
»	Preview Vocabulary
»	Read: Grace and Grandma
	Respond and Analyze T302–T303
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T303
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	 READING BRIDGE	
	Academic Vocabulary: Parts of Speech T278–T279
	Word Study: Teach Homophones 
T280–T281
	 READING BRIDGE	
	Word Study: Apply Homophones 
T304–T305
	High-Frequency Words T304

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T284–T285
	Strategy, Intervention, and On-Level/
Advanced Activities T284
	ELL Targeted Support T284
	Conferring T285
INDEPENDENT/COLLABORATIVE
	Independent Reading T285
	Literacy Activities T285
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	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T306–T307
	Strategy and Intervention Activities T306
	Fluency T306
	ELL Targeted Support T306
	Conferring T307
INDEPENDENT/COLLABORATIVE
	Independent Reading T307
	Literacy Activities T307
	Collaboration T307

	
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T436–T437
»	Use Technology to Publish Written Work
»	Share Back	
INDEPENDENT WRITING
	Opinion Essay T437
	Conferences T434
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T440–T441
»	Edit for Spelling
»	Share Back	
INDEPENDENT WRITING
	Opinion Essay T441
	Conferences T434

	
	 WRITING BRIDGE	
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	Language and Conventions: Spiral Review: Comparing with Adjectives T439
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	Spelling: Teach Homophones T442
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)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Identify Play Elements T308–T309
»	Close Read: Grace and Grandma
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T309
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Monitor Comprehension T316–T317
»	Close Read: Grace and Grandma
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T317
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T324–T325
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T325
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Explain Author’s Message T310–T311
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: 
Homophones T312–T313
	 READING BRIDGE	
	Write for a Reader: Share a Message 
T318–T319
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: 
Homographs T320–T321
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Homophones T326–T327
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T326

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T314–T315
	Strategy and Intervention Activities T314
	Fluency T314
	ELL Targeted Support T314
	Conferring T315
INDEPENDENT/COLLABORATIVE
	Independent Reading T315
	Literacy Activities T315
	Partner Reading T315
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T322–T323
	Strategy and Intervention Activities T322
	Fluency T322
	ELL Targeted Support T322
	Conferring T323
INDEPENDENT/COLLABORATIVE
	Independent Reading T323
	Literacy Activities T323
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T328–T329
	Strategy, Intervention, and On-Level/
Advanced Activities T328
	ELL Targeted Support T328
	Conferring T329
INDEPENDENT/COLLABORATIVE
	Independent Reading T329
	Literacy Activities T329
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T329 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T444–T445
»	Publish and Celebrate
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T445
	Conferences T434
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T448–T449
»	Prepare for Assessment
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T449
	Conferences T428
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T452
»	Assessment
»	Share Back
INDEPENDENT WRITING
	Assessment T453
	Conferences T434

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Homophones 
T446
	Language and Conventions: Teach Adverbs T447


	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Homographs 
T450
	Language and Conventions: Practice Adverbs T451


	 WRITING BRIDGE	
	Spelling: Homophones T454
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T454
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Standards Practice T455





 PROJECT FOCUS 	This week students will
• Research communities that have changed over time.
• Create a poster showing a part of a city or town that 
has changed.

	 LESSON 1	
T460–T463RF.3.4.b, RI.3.1, RI.3.9, W.3.7, SL.3.1

	Compare Across Texts
•	Answer the Essential Question
	Inquire
•	Introduce Inquiry Project
•	Read “From Wood to Stone”
•	Generate questions about the topic
•	Apply Academic Vocabulary

	
	
	

	 LESSON 2	
T464–T467RI.3.5, W.3.7, W.3.8, W.3.10, SL.3.1.b

	Explore and Plan
•	Informational Writing
•	Read “Yankee Stadium: 
Then and Now”
•	Set a purpose, identify a topic, and list research goals
	Conduct Research
•	Use the Library of Congress Web site
•	Gather information on a research topic

	
	
	

	 LESSON 3	
T468–T471RF.3.4.a, RI.3.2, W.3.2, W.3.2.b, W.3.8, SL.3.2

	Collaborate and Discuss
•	Analyze a Student Model
•	Identify features of informational posters
	Refine Research
•	Identify source types
•	Read “History in the Making”
•	Apply identifying source types 
to article

	
	
	

	 LESSON 4	
T472–T475RI.3.7, W.3.5, W.3.8, SL.3.1.b, L.3.1

	Extend Research
•	Find or create images
•	Incorporate images into 
poster
	Collaborate and Discuss
•	Revise & Edit: Clarity and Coherence
•	Peer review posters

	
	
	

	 LESSON 5	
T476–T477RF.3.4, W.3.1.b, W.3.4, SL.3.1.c, SL.3.4

	Celebrate and Reflect
•	Share your posters
•	Reflect on your project
	Reflect on the Unit
•	Reflect on your goals
•	Reflect on your reading
•	Reflect on your writing
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UNIT THEME
Solutions
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	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_3.png]WEEK 3
	

	
	
	Informational Text
	
	Informational Text
	
	Procedural Text
	

	
	
	Deep Down and Other Extreme Places 
to Live

	
	Earthquakes, Eruptions, and Other Events that Change Earth
	
	A Safety Plan: In Case
of Emergency


	

	
	
	
	CCSS
	
	CCSS
	
	CCSS

	READING WORKSHOP
	Minilesson 
Bank
	Time Line: Nature Rocks
	RI.3.10
	Map: When Earth 
Changes . . .
	RI.3.7
	Infographic: Emergency!
	RI.3.10

	
	
	Informational Text: Deep Down and Other Extreme Places to Live
	RI.3.10
	Informational Text: Earthquakes, Eruptions, 
and Other Events that Change Earth
	RI.3.10
	Procedural Text: A Safety Plan: In Case of Emergency
	RI.3.10

	
	
	Words that Describe or Explain a Topic
	L.3.6
	Words that Describe Events that Affect Earth
	L.3.6
	Precise Words that Tell How to Do Something
	L.3.6

	
	
	Analyze Text Features
	RI.3.7
	Analyze Text Structure
	RI.3.8
	Analyze Text Structure
	RI.3.8

	
	
	Correct or Confirm Predictions
	RI.3.10
	Synthesize Information
	RI.3.10
	Monitor Comprehension
	RI.3.1

	
	
	Talk About It: Make Pertinent Comments
	SL.3.1.b
	Write to Sources: Ask and Answer Questions
	W.3.1
	Write to Sources: Use Text Evidence
	W.3.1

	
	READING-WRITING 
WORKSHOP BRIDGE
	Academic Vocabulary
	Related Words
	L.3.4.d
	Synonyms and Antonyms
	L.3.4.d
	Context Clues
	L.3.4.a

	
	
	Word Study
	Vowel Patterns au, aw, al, augh, ough
	RF.3.3
	Vowel Patterns ei, eigh
	RF.3.3
	Words With Suffix -en
	RF.3.3.d

	
	
	Read Like a Writer
	Explain the Use of Text Features
	RI.3.10
	Analyze Graphic Features
	RI.3.7
	Explain Use of Text Structure
	RI.3.8

	
	
	Write for a Reader
	Use Text Features
	W.3.2
	Use Graphic Features
	W.3.2
	Use Text Structure
	W.3.2

	WRITING WORKSHOP
	Weekly Focus
	Introduce and Immerse
	Develop Elements
	Develop Structure

	
	Minilesson Bank
	Poetry
	W.3.10
	Composing Like a Poet
	W.3.4
	Use Line Breaks and Stanzas
	W.3.4

	
	
	What Poetry Sounds Like
	W.3.10
	Compose with Imagery
	L.3.3.a
	Select a Genre
	W.3.4

	
	
	What Poetry Looks Like
	W.3.10
	Compose with Rhythm 
and Rhyme
	W.3.4
	Revise for Word Choice: Verbs
	L.3.5.c

	
	
	Brainstorm Ideas
	W.3.4
	Compose with Alliteration
	W.3.4
	Create an Audio Recording
	SL.3.5

	
	
	Plan Your Poetry
	W.3.4
	Compose with Figurative Language
	L.3.3.a
	Create a Visual Display
	SL.3.5

	
	READING-WRITING 
WORKSHOP BRIDGE
	Spelling
	Spell Vowel Patterns au, aw, al, augh, ough
	L.3.2.f
	Spell Words with Vowel Patterns ei and eigh
	L.3.2.f
	Spell Words with Suffix -en
	L.3.2.e

	
	
	Language and Conventions
	Comparing with Adjectives
	L.3.1.g
	Comparing with Adverbs
	L.3.1.g
	Complex Sentences
	L.3.1.i



 (
UNIT 
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SKILLS OVERVIEW
)
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 (
Essential Question
)
How does the world challenge us?
	WEEK 4
	
	WEEK 5
	

	Historical Fiction
	
	Traditional Tale: Fable
	

	Nora’s Ark



	
	from Aesop’s Fox



	

	
	CCSS
	
	CCSS

	Primary Source: The Dust Bowl
	RI.3.10
	Poem: “Lesson From the Forest”
	RL.3.10

	Historical Fiction: 
Nora’s Ark
	RL.3.10
	Fables: Aesop’s Fox
	RL.3.10

	Words that Add Details about Characters’ Experiences
	L.3.6
	Words that Describe Characters and Events
	L.3.6

	Analyze Point of View
	RL.3.6
	Infer Theme
	RL.3.2

	Make Connections
	RL.3.10
	Evaluate Details
	RL.3.10

	Write to Sources: Interact with Sources
	W.3.10
	Talk About it: Ask Relevant Questions
	SL.3.1.b

	Figurative Language
	L.3.6
	Parts of Speech
	L.3.1.a

	Schwa
	RF.3.3.d
	Final Stable Syllables
	RF.3.3

	Analyze Voice
	RL.3.6
	Describe Use of Imagery
	RL.3.4

	Use Voice
	W.3.3
	Use Precise Verbs
	L.3.3.a

	Writer’s Craft
	Publish, Celebrate, and Assess

	Revise for Structure
	W.3.5
	Revise for Coherence and Clarity
	W.3.5

	Rearrange Ideas for Coherence and Clarity
	W.3.5
	Edit for Adjectives and Adverbs
	L.3.1.g

	Edit for Nouns
	L.3.1.c
	Publish and Celebrate
	W.3.6

	Edit for Comparative and Superlative Adjectives
	L.3.1.g
	Prepare for Assessment
	W.3.10

	Edit for Punctuation Marks
	L.3.2.b
	Assessment
	W.3.10

	Spell Words with the Schwa Sound
	L.3.2.e
	Spell Final Stable Syllables -le, -ture, -ive, -ize
	L.3.2.f

	Pronoun-Antecedent Agreement
	L.3.1.f
	Edit for Commas
	L.3.2.c


	WEEK 6
	

	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_4.png][image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_6.png][image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_1.png]Inquiry and Research
	

	Take a Trip!



	

	
	CCSS

	Leveled Research Articles
	RI.3.10

	Use Academic Words
	L.3.6

	Explore and Plan: Argumentative Writing
	W.3.7

	Conduct Research: Bookmarking
	W.3.8

	Argumentative Writing: Travel Brochure
	W.3.1

	Refine Research: Works Cited Page
	W.3.7

	Extend Research: Present a Slide Show
	SL.3.1.b

	Revise for Persuasive Language
	W.3.5

	Edit and Peer Review
	W.3.5

	Celebrate and Reflect
	SL.3.5





 (
RF.3.4.a, RI.3.1, RI.3.4, SL.3.1, L.3.5.a, L.3.6
) (
RF.3.3, RF.3.4, RI.3.2, RI.3.7, W.3.8, SL.3.1.d
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about informational texts and analyze text features in an informational text.
	I can use language to make connections between reading and writing.
	I can use knowledge of the sound and shape of poetry to write a poem.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the 
Time Line: Weekly Question T18–T19
	Listening Comprehension: Read Aloud “The Amazing Rainforest” T20–T21
	Informational Text T22–T23
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T23
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T32–T51 
»	Preview Vocabulary
»	Read: Deep Down and Other Extreme Places to Live
	Respond and Analyze T52–T53
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T53
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Related Words T24–T25
	Word Study: Teach Vowel Patterns 
au, aw, al, augh, ough T26–T27
	 READING BRIDGE	
	Word Study: Apply Vowel Patterns 
au, aw, al, augh, ough T54–T55
	High-Frequency Words T54

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T30–T31
	Strategy, Intervention, and On-Level/
Advanced Activities T30
	ELL Targeted Support T30
	Conferring T31
INDEPENDENT/COLLABORATIVE
	Independent Reading T31
	Literacy Activities T31
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T31 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T56–T57
	Strategy and Intervention Activities T56
	Fluency T56
	ELL Targeted Support T56
	Conferring T57
INDEPENDENT/COLLABORATIVE
	Independent Reading T57
	Literacy Activities T57
	Collaboration T57

	
	 WRITING WORKSHOP	
MINILESSON
	Poetry T338–T339
»	Poetry
»	Share Back
INDEPENDENT WRITING
	Poetry T339
	Conferences T336
	 WRITING WORKSHOP	
MINILESSON
	Poetry T342–T343
»	What Poetry Sounds Like
»	Share Back
INDEPENDENT WRITING
	Poetry T343
	Conferences T336

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Vowel Patterns 
au, aw, al, augh, ough T340
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T340
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Adverbs T341
	 WRITING BRIDGE	
	Spelling: Teach Vowel Patterns 
au, aw, al, augh, ough T344
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Oral Language: Comparing with Adjectives T345




 (
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)
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 (
RF.3.3.c, W.3.5, SL.3.1.a, SL.3.1.c, L.3.1.g
) (
RF.3.4.b, RI.3.7, W.3.5, SL.3.4, L.3.1.g
) (
RF.3.4.b, RI.3.5, RI.3.7, W.3.4, SL.3.1, L.3.1.g
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Text Features T58–T59
»	Close Read: Deep Down and Other Extreme Places to Live
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T59
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Correct or Confirm Predictions T66–T67
»	Close Read: Deep Down and Other Extreme Places to Live
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T67
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T74–T75
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T75
»	Weekly Question


	 READING BRIDGE	
	Read Like a Writer: Explain the Use of Text Features T60–T61
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Vowel 
Patterns au, aw, al, augh, ough T62–T63
	 READING BRIDGE	
	Write for a Reader: Use Text Features 
T68–T69
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: 
Homophones T70–T71
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Vowel Patterns au, 
aw, al, augh, ough T76–T77
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T76

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T64–T65
	Strategy and Intervention Activities T64
	Fluency T64
	ELL Targeted Support T64
	Conferring T65
INDEPENDENT/COLLABORATIVE
	Independent Reading T65
	Literacy Activities T65
	Partner Reading T65
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T72–T73
	Strategy and Intervention Activities T72
	Fluency T72
	ELL Targeted Support T72
	Conferring T73
INDEPENDENT/COLLABORATIVE
	Independent Reading T73
	Literacy Activities T73

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T78–T79
	Strategy, Intervention, and On-Level/
Advanced Activities T78
	ELL Targeted Support T78
	Conferring T79
INDEPENDENT/COLLABORATIVE
	Independent Reading T79
	Literacy Activities T79
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T79 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Poetry T346–T347
»	What Poetry Looks Like
»	Share Back
INDEPENDENT WRITING
	Poetry T347
	Conferences T336
	 WRITING WORKSHOP	
MINILESSON
	Poetry T350–T351
»	Brainstorm Ideas
»	Share Back
INDEPENDENT WRITING
	Poetry T351
	Conferences T336
	 WRITING WORKSHOP	
MINILESSON
	Poetry T354
»	Plan Your Poetry
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T355 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T336

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Vowel 
Patterns au, aw, al, augh, ough T348
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Language and Conventions: Teach Comparing with Adjectives T349

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: 
Homophones T352
	Language and Conventions: Practice Comparing with Adjectives T353

	 WRITING BRIDGE	
	Spelling: Vowel Patterns au, aw, al, 
augh, ough T356
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T356
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Standards Practice T357






 (
RI.3.4, RI.3.10, W.3.4, SL.3.1.d, L.3.1.g, L.3.3.a
) (
RF.3.3.c, RI.3.7, W.3.4, SL.3.1, L.3.3.a
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about informational texts and analyze text structure in informational text.
	I can develop knowledge about language to make connections between reading and writing.
	I can use knowledge of the sound and shape of poetry to write a poem.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Map: Weekly Question T84–T85
	Listening Comprehension: Read Aloud: “Hurricane Force” T86–T87
	Informational Text T88–T89
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T89
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T98–T109
»	Preview Vocabulary
»	Read: Earthquakes, Eruptions, and Other Events that Change Earth
	Respond and Analyze T110–T111
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T111
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Synonyms and Antonyms T90–T91
	Word Study: Teach Vowel Patterns 
ei, eigh T92–T93
	 READING BRIDGE	
	Word Study: Apply Vowel Patterns 
ei, eigh T112–T113
	High-Frequency Words T112

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T96–T97
	Strategy, Intervention, and On-Level/
Advanced Activities T96
	ELL Targeted Support T96
	Conferring T97
INDEPENDENT/COLLABORATIVE
	Independent Reading T97
	Literacy Activities T97
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T97 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T114–T115
	Strategy and Intervention Activities T114
	Fluency T114
	ELL Targeted Support T114
	Conferring T115
INDEPENDENT/COLLABORATIVE
	Independent Reading T115
	Literacy Activities T115
	Partner Reading T115

	
	 WRITING WORKSHOP	
MINILESSON
	Poetry T362–T363
»	Composing Like a Poet
»	Share Back
INDEPENDENT WRITING
	Poem T363
	Conferences T360
	 WRITING WORKSHOP	
MINILESSON
	Poetry T366–T367
»	Compose with Imagery
»	Share Back
INDEPENDENT WRITING
	Poem T367
	Conferences T360

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Vowel Patterns ei and 
eigh T364
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T364
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Comparing with Adjectives T365
	 WRITING BRIDGE	
	Spelling: Teach Vowel Patterns 
ei and eigh T368
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Comparing with 
Adverbs T369
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Text Structure T116–T117
»	Close Read: Earthquakes, Eruptions, 
and Other Events that Change Earth
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T117
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Synthesize Information T124–T125
»	Close Read: Earthquakes, Eruptions, 
and Other Events that Change Earth
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T125
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T132–T133
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T133
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Graphic Features T118–T119
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Vowel 
Patterns ei, eigh T120–T121
	 READING BRIDGE	
	Write for a Reader: Use Graphic Features T126–T127
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Vowel 
Patterns au, aw, al, augh, and ough 
T128–T129
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Vowel Patterns 
ei, eigh T134–T135
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T134

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T122–T123
	Strategy and Intervention Activities T122
	Fluency T122
	ELL Targeted Support T122
	Conferring T123
INDEPENDENT/COLLABORATIVE
	Independent Reading T123
	Literacy Activities T123
	Partner Reading T123
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T130–T131
	Strategy and Intervention Activities T130
	Fluency T130
	ELL Targeted Support T130
	Conferring T131
INDEPENDENT/COLLABORATIVE
	Independent Reading T131
	Literacy Activities T131
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T136–T137
	Strategy, Intervention, and On-Level/
Advanced Activities T136
	ELL Targeted Support T136
	Conferring T137
INDEPENDENT/COLLABORATIVE
	Independent Reading T137
	Literacy Activities T137
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T137 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Poetry T370–T371
»	Compose with Rhythm and Rhyme
»	Share Back
INDEPENDENT WRITING
	Poem T371
	Conferences T360
	 WRITING WORKSHOP	
MINILESSON
	Poetry T374–T375
»	Compose with Alliteration
»	Share Back
INDEPENDENT WRITING
	Poem T375
	Conferences T360
	 WRITING WORKSHOP	
MINILESSON
	Poetry T378
»	Compose with Figurative Language
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T379 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T360

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Vowel 
Patterns ei and eigh T372
	Language and Conventions: Teach Comparing with Adverbs T373


	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Words with 
Vowel Patterns au, aw, al, augh, 
and ough T376
	Language and Conventions: Practice Comparing with Adverbs T377

	 WRITING BRIDGE	
	Spelling: Vowel Patterns ei and 
eigh T380
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T380
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Standards Practice T381
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	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about informational texts and analyze the text structure in a 
procedural text.
	I can use language to make connections between reading and writing.
	I can use knowledge of the sound and shape of poetry to write a poem.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question 
T142–T143
	Listening Comprehension: Read Aloud: “Conducting a School Fire Drill” 
T144–T145
	Procedural Text T146–T147
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T147
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T156–T169
»	Preview Vocabulary
»	Read: A Safety Plan: In Case of Emergency
	Respond and Analyze T170–T171
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T171
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Context Clues T148–T149
	Word Study: Teach Words with Suffix 
-en T150–T151
	 READING BRIDGE	
	Word Study: Apply Words with Suffix 
-en T172–T173
	High-Frequency Words T172

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T154–T155
	Strategy, Intervention, and On-Level/
Advanced Activities T154
	ELL Targeted Support T154
	Conferring T155
INDEPENDENT/COLLABORATIVE
	Independent Reading T155
	Literacy Activities T155
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T155 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T174–T175
	Strategy and Intervention Activities T174
	Fluency T174
	ELL Targeted Support T174
	Conferring T175
INDEPENDENT/COLLABORATIVE
	Independent Reading T175
	Literacy Activities T175
	Collaboration T175

	
	 WRITING WORKSHOP	
MINILESSON
	Poetry T386–T387
»	Use Line Breaks and Stanzas
»	Share Back
INDEPENDENT WRITING
	Poetry T387
	Conferences T384
	 WRITING WORKSHOP	
MINILESSON
	Poetry T390–T391
»	Select a Genre
»	Share Back
INDEPENDENT WRITING
	Poetry T391
	Conferences T384

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Words with Suffix 
-en T388
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T388
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Comparing with Adverbs T389
	 WRITING BRIDGE	
	Spelling: Teach Words with Suffix 
-en T392
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Complex Sentences T393


 (
UNIT 
5
 WEEK 
3
SUGGESTED WEEKLY PLAN
)

Copyright © Savvas Learning Company LLC. All Rights Reserved.
Savvas is not responsible for any modifications made by end users to the content posted in its original format.
 (
RI.3.2, W.3.1, W.3.1.b, SL.3.5, L.3.1, L.3.1.i
) (
RI.3.1, W.3.4, SL.3.5, L.3.1.h, L.3.6
) (
RI.3.8, RI.3.10, W.3.4, L.3.1.i, L.3.3.a, L.3.5.c
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Text Structure T176–T177
»	Close Read: A Safety Plan: In Case 
of Emergency
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T177
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Monitor Comprehension T184–T185
»	Close Read: A Safety Plan: In Case 
of Emergency
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T185
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T192–T193
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T193
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Explain Use of 
Text Structure T178–T179
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Words 
with Suffix -en T180–T181
	 READING BRIDGE	
	Write for a Reader: Use Text Structure T186–T187
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Vowel 
Patterns ei, eigh T188–T189
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Words with Suffix 
-en T194–T195
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T194

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T182–T183
	Strategy and Intervention Activities T182
	Fluency T182
	ELL Targeted Support T182
	Conferring T183
INDEPENDENT/COLLABORATIVE
	Independent Reading T183
	Literacy Activities T183
	Partner Reading T183
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T190–T191
	Strategy and Intervention Activities T190
	Fluency T190
	ELL Targeted Support T190
	Conferring T191
INDEPENDENT/COLLABORATIVE
	Independent Reading T191
	Literacy Activities T191
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T196–T197
	Strategy, Intervention, and On-Level/
Advanced Activities T196
	ELL Targeted Support T196
	Conferring T197
INDEPENDENT/COLLABORATIVE
	Independent Reading T197
	Literacy Activities T197
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T197 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Poetry T394–T395
»	Revise for Word Choice: Verbs
»	Share Back
INDEPENDENT WRITING
	Poetry T395
	Conferences T384
	 WRITING WORKSHOP	
MINILESSON
	Poetry T398–T399
»	Create an Audio Recording
»	Share Back
INDEPENDENT WRITING
	Poetry T399
	Conferences T384
	 WRITING WORKSHOP	
MINILESSON
	Poetry T402
»	Create a Visual Display
»	Share Back
INDEPENDENT WRITING
	Select a Genre T403
	Conferences T384

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Words 
with Suffix -en T396
	Language and Conventions: Teach Complex Sentences T397

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Vowel Patterns 
ei, eigh T400
	Language and Conventions: Practice Complex Sentences T401

	 WRITING BRIDGE	
	Spelling: Words with Suffix -en T404
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T404
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions:
Standards Practice T405






 (
RF.3.3.d, RF.3.4.b, W.3.8, SL.3.1, L.3.5.a
) (
RL.3.6, RF.3.3.d, RF.3.4, W.3.5, SL.3.1.c, L.3.1.f
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about themes concerning solutions by analyzing point of view in historical fiction.
	I can develop knowledge about language to make connections between reading and writing.
	I can use knowledge of the sound and shape of poetry to write a poem.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Primary Source: Weekly Question T202–T203
	Listening Comprehension: Read Aloud: “Black Blizzards” T204–T205
	Historical Fiction T206–T207
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T207
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T216–T237
»	Preview Vocabulary
»	Read: Nora’s Ark
	Respond and Analyze T238–T239
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T239
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Figurative Language T208–T209
	Word Study: Teach Schwa Vowel Sound T210–T211
	 READING BRIDGE	
	Word Study: Apply Schwa Vowel Sound T240–T241
	High-Frequency Words T240

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T214–T215
	Strategy, Intervention, and On-Level/
Advanced Activities T214
	ELL Targeted Support T214
	Conferring T215
INDEPENDENT/COLLABORATIVE
	Independent Reading T215
	Literacy Activities T215
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T215 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T242–T243
	Strategy and Intervention Activities T242
	Fluency T242
	ELL Targeted Support T242
	Conferring T243
INDEPENDENT/COLLABORATIVE
	Independent Reading T243
	Literacy Activities T243

	
	 WRITING WORKSHOP	
MINILESSON
	Poetry T410–T411
»	Revise for Structure
»	Share Back
INDEPENDENT WRITING
	Poem T411
	Conferences T408
	 WRITING WORKSHOP	
MINILESSON
	Poetry T414–T415
»	Rearrange Ideas for Coherence and Clarity
»	Share Back
INDEPENDENT WRITING
	Poem T415
	Conferences T408

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Words with the 
Schwa Sound T412
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T412
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Complex Sentences T413
	 WRITING BRIDGE	
	Spelling: Teach Words with the Schwa Sound T416
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Pronoun-Antecedent Agreement T417
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Point of View T244–T245
»	Close Read: Nora’s Ark
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T245
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Make Connections T252–T253
»	Close Read: Nora’s Ark
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T253
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T260–T261
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T261
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Voice 
T246–T247
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Schwa 
Vowel Sound T248–T249
	 READING BRIDGE	
	Write for a Reader: Use Voice 
T254–T255
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Words 
with the Suffiix -en T256–T257
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Schwa Vowel Sound 
T262–T263
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T262

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T250–T251
	Strategy and Intervention Activities T250
	Fluency T250
	ELL Targeted Support T250
	Conferring T251
INDEPENDENT/COLLABORATIVE
	Independent Reading T251
	Literacy Activities T251
	Partner Reading T251
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T258–T259
	Strategy and Intervention Activities T258
	Fluency T258
	ELL Targeted Support T258
	Conferring T259
INDEPENDENT/COLLABORATIVE
	Independent Reading T259
	Literacy Activities T259
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T264–T265
	Strategy, Intervention, and On-Level/
Advanced Activities T264
	ELL Targeted Support T264
	Conferring T265
INDEPENDENT/COLLABORATIVE
	Independent Reading T265
	Literacy Activities T265
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T265 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Poetry T418–T419
»	Edit for Nouns
»	Share Back
INDEPENDENT WRITING
	Poem T419
	Conferences T408
	 WRITING WORKSHOP	
MINILESSON
	Poetry T422–T423
»	Edit for Comparative and Superlative Adjectives
»	Share Back
INDEPENDENT WRITING
	Poem T423
	Conferences T408
	 WRITING WORKSHOP	
MINILESSON
	Poetry T426
»	Edit for Punctuation Marks
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T427 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T408

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Words 
with the Schwa Sound T420
	Language and Conventions: Teach Pronoun-Antecedent Agreement T421

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Words with 
the Suffix -en T424
	Language and Conventions: Practice Pronoun-Antecedent Agreement T425

	 WRITING BRIDGE	
	Spelling: Spell Words with the Schwa 
Sound T428
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T428
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	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about themes concerning solutions by reading a text that helps me infer theme in traditional tales.
	I can develop knowledge about language to make connections between reading and writing.
	I can use knowledge of the sound and shape of poetry to write a poem.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Writing Workshop Assessment
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
	Test Banks
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Poem: Weekly Question T270–T271
	Listening Comprehension: Read Aloud: “The Ant and the Grasshopper” 
T272–T273
	Traditional Tales T274–T275
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T275
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T284–T299
»	Preview Vocabulary
»	Read: Aesop’s Fox
	Respond and Analyze T300–T301
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T301
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Parts of Speech T276–T277
	Word Study: Teach Final Stable Syllables -le, -ture, -ive, -ize T278–T279
	 READING BRIDGE	
	Word Study: Apply Final Stable Syllables 
-le, -ture, -ive, -ize T302–T303
	High-Frequency Words T302

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T282–T283
	Strategy, Intervention, and On-Level/
Advanced Activities T282
	ELL Targeted Support T282
	Conferring T283
INDEPENDENT/COLLABORATIVE
	Independent Reading T283
	Literacy Activities T283
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T283 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
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 PROJECT FOCUS 	This week students will
• write a travel brochure that persuades readers to visit, or not visit, a place likely to be affected by a natural disaster.
• research evidence that supports their claim and persuades their audience.

	 LESSON 1	
T458–T461RI.3.1, RI.3.2, W.3.7, SL.3.1, SL.3.1.b

	Compare Across Texts
•	Answer the Essential Question
	Inquire
•	Introduce Inquiry Project
•	Read “Living on a Fault Line”
•	Generate questions about the topic
•	Apply Academic Vocabulary

	
	
	

	 LESSON 2	
T462–T465RI.3.5, W.3.5, W.3.7, SL.3.1, SL.3.1.b

	Explore and Plan
•	Argumentative Writing
•	Read: “The City I Love”
•	Apply characteristics of text
	Conduct Research
•	Bookmarking Web pages
•	Identify relevant information

	
	
	

	 LESSON 3	
T466–T469RI.3.2, RI.3.6, W.3.1, W.3.8, W.3.10

	Collaborate and Discuss
•	Read a Student Model
•	Identify features of argumentative text
	Refine Research
•	Cite sources on works cited page
•	Read “A Mighty Flood”
•	Apply citing sources

	
	
	

	 LESSON 4	
T470–T473RI.3.7, W.3.8, SL.3.3, SL.3.6, L.3.1

	Extend Research
•	Create a slide show
•	Use a slide show to support a claim in an argumentative text
	Collaborate and Discuss
•	Revise & Edit: Persuasive Language
•	Peer review travel brochures

	
	
	

	 LESSON 5	
T474–T475W.3.10, SL.3.3, SL.3.4, L.3.1, L.3.3

	Celebrate and Reflect
•	Present your travel brochure
•	Reflect on your project
	Reflect on the Unit
•	Reflect on your goals
•	Reflect on your reading
•	Reflect on your writing
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